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Prologo

Prologo

Gracias por adquirir este producto Topcon. EI material disponible en
este manual (en lo sucesivo el Manual) ha sido preparado por Topcon
Positioning Systems, Inc. (TPS) para los propietarios de productos
Topcon, y esta disefiado para ayudar al propietario en el uso del
receptor. Su utilizacion esta sujeta a los presentes términos y
condiciones (los Términos y Condiciones).

Le rogamos que lea detenidamente estos Términos
y Condiciones.

Términos y Condiciones

USO. Este producto esta disefiado para ser usado por un profesional.
El usuario debera conocer el uso seguro del producto y aplicar los
diferentes procedimientos de seguridad recomendados por la agencia
de proteccién del gobierno local, tanto en lugares de trabajo
comerciales como de uso privado.

DERECHOS DE REPRODUCCION. TPS posee la propiedad
intelectual y los derechos de reproduccion de toda la informacion
contenida en este Manual. Reservados todos los derechos. No esta
permitido utilizar, acceder, copiar, guardar, mostrar, crear trabajos
derivados, vender, modificar, publicar, distribuir o permitir el acceso
por parte de terceros a los gréficos, contenido, datos e informacion de
este Manual sin el consentimiento expreso por escrito de TPS. Esta
informacion s6lo podréa utilizarse para el uso y cuidado del receptor.
La informacion de este Manual es un valioso recurso de TPS y ha sido
desarrollada dedicando considerables cantidades de trabajo, tiempo y
dinero. Es el resultado de la planificacion, coordinacion y seleccion
original por parte de TPS.



Las MARCAS NET-G3, Topcon Tools, Topcon Link, TopNET,
Topcon y Topcon Positioning Systems son marcas comerciales o
marcas registradas de TPS. Windows® es una marca registrada de
Microsoft Corporation. La marca y los logotipos Bluetooth® son
propiedad de Bluetooth SIG, Inc., y el uso de dichas marcas por parte
de Topcon Positioning Systems, Inc. se hace con licencia del
propietario. Los nombres de otros productos y empresas mencionados
en este documento podrian ser marcas comerciales de sus respectivos
propietarios.

EXENCION DE GARANTIA. APARTE DE LAS CLAUSULAS
ESPECIFICADAS EN ANEXO O EN LA CARTA DE GARANTIA
QUE SE ENTREGA CON EL PRODUCTO, ESTE MANUAL Y EL
RECEPTOR NO ESTAN CUBIERTOS POR NINGUN OTRO TIPO
DE GARANTIA. NO EXISTEN OTRAS GARANTIAS. TPS
DECLINA TODA GARANTIA IMPLICITA DE
APROVECHAMIENTO O ADECUACION PARA PROPOSITOS O
USOS PARTICULARES. TPS Y SUS DISTRIBUIDORES NO
SERAN RESPONSABLES DE LOS ERRORES TECNICOS O
TIPOGRAFICOS NI DE LAS OMISIONES DE ESTE MANUAL;
TAMPOCO SE RESPONSABILIZARAN DE LOS DANOS
ACCIDENTALES O CONSECUENTES RESULTANTES DEL
SUMINISTRO, RENDIMIENTO O UTILIZACION DE ESTE
MATERIAL O DEL PRODUCTO. ESTA EXENCION DE
RESPONSABILIDAD INCLUYE, SIN CARACTER LIMITATIVO,
LOS DANOS POR PERDIDA DE TIEMPO, PERDIDA O
DESTRUCCION DE DATOS, PERDIDA DE BENEFICIOS,
DESCUENTOS O GANANCIAS, O IMPOSIBILIDAD DEL USO
DEL PRODUCTO. ASIMISMO TPS NO SE RESPONSABILIZARA
DE LOS DANOS O COSTES EN LOS QUE SE INCURRA
RELACIONADOS CON LA OBTENCION DE PRODUCTOS O
SOFTWARE DE RECAMBIO, RECLAMACIONES POR PARTE
DE TERCEROS, INADECUACION O CUALQUIER OTRO TIPO
DE COSTES. EN CUALQUIER CASO, TPS NO SERA
RESPONSABLE DE LOS DANOS U OTROS PERJUICIOS
OCASIONADOS A SU PERSONA U OTRAS PERSONAS O
ENTIDADES POR IMPORTE SUPERIOR AL PRECIO DE
ADQUISICION DEL PRODUCTO.
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ACUERDO DE LICENCIA. El uso de los programas informéticos o
software suministrados por TPS o descargados del sitio web de TPS (el
"Software) relacionados con el receptor implica la aceptacion y el
compromiso de cumplimiento de los términos y condiciones de este
manual. Se concede al usuario una licencia personal, no exclusivay no
transferible para la utilizacion del Software en los términos
establecidos en este documento y, en cualquier caso, para un Gnico
Producto u ordenador. No se asignara ni transferira el Software ni esta
licencia sin el consentimiento expreso por escrito de TPS. Esta licencia
tendra validez hasta su rescision. El usuario podra rescindir la licencia
en cualquier momento destruyendo el Software y el Manual. TPS
podra rescindir la licencia en caso de incumplimiento por parte del
usuario de cualquiera de los Términos o Condiciones. El usuario se
compromete a destruir el Software y el Manual a la finalizacion del uso
del Producto. TPS posee todos los derechos de propiedad,
reproducciony propiedad intelectual relacionados con el Software. En
caso de no aceptacion de estos términos de licencia se ruega devolver
el Software y el Manual no utilizados.

CONFIDENCIALIDAD. Este Manual, su contenido y el Software (en
conjunto, la "Informacién Confidencial™) son informacién
confidencial propiedad de TPS. El usuario se compromete a tratar la
Informacién Confidencial de TPS con el mismo grado de reserva que
utilizaria para salvaguardar sus propios secretos comerciales mas
valiosos. Lo estipulado en el parrafo precedente no impedira al usuario
divulgar entre sus empleados la Informacion Confidencial necesaria
para el correcto funcionamiento y cuidado del Producto. Dichos
empleados deberan también respetar la confidencialidad de esta
informacion. En caso de que el usuario se vea legalmente obligado a
revelar la Informacion Confidencial, debera avisar inmediatamente a
TPS para que pueda solicitar una orden de proteccién o establecer la
solucion adecuada.
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SITIO WEB; OTRAS DECLARACIONES. Ninguna declaracion
contenida en el sitio web de TPS (o en cualquier otro sitio web), o0 en
otros anuncios o documentos de TPS, o realizada por cualquier
empleado o subcontratista independiente de TPS puede modificar
estos términos y condiciones (incluyendo la licencia, garantia y
limitacion de responsabilidades del software).

SEGURIDAD. El uso inadecuado del receptor puede ocasionar dafios
a las personas o a los bienes o un funcionamiento defectuoso del
producto. El producto sélo debera ser reparado en centros de servicio
de garantia TPS autorizados. Los usuarios deberan conocer y observar
las medidas de seguridad que se describen en el Anexo
correspondiente.

VARIOS. TPS podra corregir, modificar, sustituir o cancelar en
cualquier momento los términos y condiciones anteriormente
mencionados. Los términos y condiciones arriba indicados se regiran
e interpretaran de conformidad con las leyes del Estado de California,
sin tener en cuenta los conflictos de leyes.
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Convenciones del manual

Este manual utiliza las siguientes convenciones:

Ejemplo Descripcién

File » Exit Haga clic en el menu File y a continuacion en
Exit.

Connection Indica el nombre de un cuadro de dialogo o una
pantalla.

Frequency Indica un campo de un cuadro de diélogo o

pantalla, o una pestafia dentro de un cuadro de
dialogo o pantalla.

Enter Pulse o haga clic en el boton o tecla con la
inscripcion Enter.

Informacion adicional sobre la configuracion, el
mantenimiento o la instalacion de un sistema.

' Informacién complementaria que puede ayudarle a
RECONENDAGN configurar, mantener o instalar un sistema.

Informacién complementaria que puede repercutir
en el funcionamiento o el rendimiento del sistema,
las mediciones o la seguridad personal.

Notificacién de que una accién podria afectar de
/\ forma negativa al funcionamiento o el rendimiento
GEETEWD)  del sistema, la integridad de los datos o la salud de
las personas.
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Notificacion de que una accidn provocara dafios en
|.I.|.I. el sistema, pérdida de datos, pérdida de garantia o
“€S~  |esiones personales.

Esta accion no debera ejecutarse bajo ninguna
circunstancia.

Manual del Operador de NET-G3



Capitulo 1

Introduccion

El receptor NET-G3 (Figura 1-1 en la pagina 1-2) es un receptor
GNSS multifrecuencia disefiado para ser el receptor de estacion de
referencia mas avanzado y cémodo disponible actualmente. El
receptor es una estacion de referencia permanente o semipermanente
especifica prevista para ser utilizada en los mercados de precisién. Los
mercados de precision son los especializados en equipos, subsistemas,
componentes y software para topografia, construccién, cartografia
comercial, ingenieria civil, agricultura de precision, construccion
terrestre, control de maquinaria agricola, cartografia fotogramétrica,
hidrografia y cualquier uso directamente relacionado con estas
especialidades.

El NET-G3 puede recibir y procesar distintos tipos de sefiales
(incluidas las Gltimas sefiales GPS L2C, GPS L5, GLONASS C/A L2
y GALILEO), aumentando la precision y la fiabilidad de la solucion,
en especial en condiciones adversas en el lugar de trabajo. Las
funciones siguientes se combinan para ofrecer un sistema de
posicionamiento eficaz y adecuado para cualquier levantamiento o
aplicacién que requiera una gran precision de tiempo y
posicionamiento.

* GNSS

* Deteccion de varias frecuencias

 Salida 1PPS (un impulso por segundo) y marcado de tiempo de
eventos externos

 Entrada de frecuencia externa y salida de frecuencia interna
» Conexiones de red

Algunas otras funciones, incluyendo la reduccion de multicamino
consiguen aumentar la intensidad de recepcion de las sefiales débiles y
en lugares cubiertos. El receptor proporciona la funcionalidad,
precisién, disponibilidad e integridad necesarias para que la
adquisicion y gestion de datos sea rapida y sencilla.



Introduccién

Figura 1-1. Receptor NET-G3

Principios de funcionamiento

Tanto si se basan en una sola estacion de referencia o en una red de
varias estaciones, las aplicaciones estaticas y mdviles que usan datos
GNSS procedentes de una estacion de referencia de alto rendimiento
se benefician de los mas altos niveles de fidelidad y precision.

Esta seccion ofrece una descripcion general de los sistemas mundiales
de navegacion por satélite (GNSS, por sus siglas en inglés) existentes
y propuestos y las funciones del receptor para ayudarle a comprender
y aplicar los principios de funcionamiento basicos, permitiéndole
obtener el maximo rendimiento de su receptor.

Descripcion general de GNSS

En la actualidad, los tres siguientes sistemas mundiales de navegacién
por satélite (GNSS), ofrecen servicios de posicionamiento y
navegacion por radio con visibilidad directa, velocidad y tiempo a
escala mundial y con todo tipo de condiciones meteoroldgicas a
cualquier usuario equipado con un receptor de seguimiento GNSS
situado sobre la superficie terrestre o cerca de ella:

» GPS. Sistema de posicionamiento mundial mantenido y
operado por el Departamento de Defensa de Estados Unidos. Si
desea informacion sobre el estado de este sistema visite el sitio
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Principios de funcionamiento

web del Observatorio Naval de EE. UU. o el sitio web del
Servicio de Guardacostas de EE. UU.

* GLONASS. Sistema mundial de navegacién por satélite
mantenido y operado por el Ministerio de Defensa de la
Federacion Rusa. Si desea informacion sobre el estado de este
sistema, visite el sitio web del Centro Coordinador de
Informacién Cientifica.

e GALILEO. Un sistema de posicionamiento mundial de préxima
aparicion mantenido y operado por las Industrias Galileo, un
consorcio formado por varias agencias/empresas espaciales
europeas que trabajan en estrecha cooperacion con la Agencia
Espacial Europea. A diferencia de los sistemas GPS y
GLONASS, se trata de una iniciativa civil, y se encuentra
actualmente en fase de desarrollo y validacion. Para obtener
informacion acerca del estado de este sistema, visite el sitio web
de las Industrias Galileo.

A pesar de las numerosas diferencias técnicas en su implantacion, los
sistemas de posicionamiento por satélite tienen en comun tres
componentes esenciales:

» Espacio. Los satélites GPS, GLONASS y GALILEO orbitan
aproximadamente a una distancia de 12 000 millas nauticas de
la Tierra, y estan dotados de reloj y radio. Estos satélites emiten
sefiales de determinacion de distancias y diversos datos digitales
(efemérides, almanaques, correcciones de tiempo y frecuencia,
etc.).

» Control. Un conjunto de equipos terrestres distribuidos por toda
la Tierra que controlan los satélites y cargan datos, incluyendo
las correcciones de reloj y nuevas efemérides (posiciones de los
satélites en funcion del tiempo) para garantizar que los satélites
transmiten correctamente la informacion.

» Usuarios. La comunidad y los militares que usan los receptores
GNSS para calcular posiciones.

Calculo de posiciones absolutas

Cuando se calcula una posicion absoluta, un receptor fijo 0 movil
determina su posicion tridimensional con respecto al origen de un
sistema de coordenadas geocéntrico fijado a la Tierra. Para calcular
esta posicion, el receptor mide las distancias (denominadas
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Introduccién

pseudorrangos) entre su posicion y al menos cuatro satélites. En los
pseudorrangos medidos se corrigen las diferencias de reloj (del
receptor y los satélites) y los plazos de propagacién de la sefial por
efecto de las condiciones atmosféricas. Las posiciones de los satélites
se calculan a partir de los datos de efemérides transmitidos al receptor
en mensajes de navegacion. Cuando se usa un Unico sistema satelital
se requieren como minimo cuatro satélites para calcular una posicion.
Cuando se usan varios sistemas satelitales (GPS, GLONASS,
GALILEO), el receptor debera recibir sefiales de cinco o mas satélites
para calcular las distintas escalas de tiempo empleadas en estos
sistemas y obtener una posicion absoluta.

Calculo de posiciones diferenciales

DGPS o GPS diferencial es una técnica de posicionamiento relativo en
la que las mediciones de dos 0 mas receptores distantes se combinan y
procesan mediante algoritmos sofisticados para calcular con gran
precisién las coordenadas relativas del receptor.

DGPS admite distintas técnicas de implantacion que pueden
clasificarse de acuerdo con los siguientes criterios:

 El tipo de mediciones GNSS utilizado, ya sean mediciones
diferenciales de fase de codigo o mediciones diferenciales de
fase de portadora.

» Si se requieren los resultados en tiempo real o en diferido. Las
aplicaciones en tiempo real se pueden dividir a su vez en
funcion de la fuente de datos diferenciales y el enlace de
comunicacién utilizados.

En el enfoque mas tradicional del DGPS se sitta un receptor en una
posicion topografica conocida y se identifica como receptor de
referencia o equipo base. Se sitla otro receptor en una posicién
desconocida y se identifica como receptor remoto o receptor moévil. El
equipo de referencia obtiene las mediciones de fase de codigo y de fase
de portadora de los satélites GNSS que tiene a la vista.

» En las aplicaciones en tiempo real, estas mediciones junto con
las coordenadas del equipo de referencia se afiaden a la norma
industrial RTCM (o conjunto de normas patentadas establecidas
para transmitir datos diferenciales) y se envian a los receptores
remotos a través de un enlace de comunicacion de datos. El
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Principios de funcionamiento

receptor remoto aplica la informacién de medicién transmitida a
sus mediciones observadas de los mismos satélites.

» En aplicaciones en diferido, las mediciones simultaneas de los
equipos de referencia y remotos se registran normalmente en la
memoria interna del receptor (no se envian a través del enlace
de comunicacién).

Mas tarde, los datos se descargan en un ordenador y se combi-
nany procesan.

Mediante esta técnica se pueden reducir significativamente los
errores asociados al espacio (como los errores orbitales de los
satélites, los errores ionosféricos y los errores troposféricos),
mejorando asi la precision del célculo de la posicion.

Hay muchas aplicaciones de posicionamiento diferencial, entre las que
se incluyen el levantamiento con postproceso, el levantamiento
cinemaético en tiempo real, las radiobalizas maritimas, los satélites
geoestacionarios (como en el servicio OmniSTAR) y los sistemas de
aumento basados en satélites (WAAS, EGNOS, MSAS).

El método cinematico en tiempo real (RTK) es el modo de
levantamiento en tiempo real mas preciso. EI RTK requiere al menos
dos receptores que obtengan datos de navegacion y un enlace de datos
de comunicacion entre los receptores. Normalmente, uno de los
receptores se encuentra en una posicion conocida (base) y el otro en
una posicion desconocida (movil). El receptor base recoge las
mediciones de fase de portadora, genera las correcciones RTK y envia
estos datos al receptor mévil. El receptor mavil procesa los datos
transmitidos con sus propias observaciones de fase de portadora para
calcular su posicion relativa con gran exactitud, consiguiendo una
precisién RTK de hasta 1 cm en horizontal y 1,5 cm en vertical.

Componentes esenciales para obtener resultados
de calidad

Para conseguir un célculo de posicion de calidad se requiere el
concurso de los siguientes elementos:

 Precision. La precision de una posicion depende
fundamentalmente de la geometria del satélite (Dilucién de

Precision Geométrica 0 GDOP) y los errores de medicion
(distancias). — El posicionamiento diferencial (DGPS y RTK)
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Introduccién

reduce significativamente los errores atmosféricos y orbitales y
contrarresta las sefiales de Disponibilidad Selectiva (SA, por sus
siglas en inglés) emitidas por el Departamento de Defensa de
los EE.UU. con las sefiales GPS. — Cuantos més satélites se
tengan a la vista, con mayor fuerza se recibird la sefial, mas baja
serd la dilucion de precision y mayor serd la precision del
posicionamiento.

 Disponibilidad. La disponibilidad de los satélites afecta al
célculo de posiciones validas. Cuantos mas satélites se captan,
mayor es la validez y la precision de la posicion. Los obstaculos
naturales o construidos por el hombre pueden bloquear,
interrumpir y distorsionar las sefiales, disminuyendo el nimero
de satélites disponibles y afectando negativamente a la
recepcion de la sefial.

* Integridad. La tolerancia de fallos permite a una posicion tener
maés integridad, aumentando la precision. Para conseguir la
tolerancia de fallos se combinan varios factores, entre los que se
incluyen:

- LaRAIM (Receiver Autonomous Integrity Monitoring —
Supervisién de Integridad Autonoma de Receptor-) detecta
los satélites GNSS defectuosos y los elimina del calculo de
la posicién.

- Se requieren cinco 0 mas satélites visibles cuando se utiliza
Unicamente un sistema, GPS 0 GLONASS, y seis 0 méas en
situaciones mixtas.

- Los sistemas de aumento basados en satélites (WAAS,
EGNOS, etc.) crean y transmiten, junto con las correcciones
DGPS, informacion de la integridad de los datos (por
ejemplo, advertencias de la salud del satélite).

- Efemérides y almanaques actuales.

Conclusion

En esta presentacion general se han explicado los fundamentos del
posicionamiento por satélite. Para ampliar informacidn visite el sitio
web de TPS.
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Principios de funcionamiento

Presentacion del receptor

El receptor NET-G3, con tecnologia de seguimiento G3, representa lo
ultimo en tecnologia apta para GNSS y ofrece un valor superior
gracias a su capacidad para adaptarse a los cambios en la
intensificacion de las sefiales GNSS a través de sencillas
actualizaciones de firmware, protegiendo la inversion al maximo
grado posible.

Cuando se enciende el equipo y se completa el proceso de
autocomprobacion, se inicializan los 72 canales del receptor y éste
comienza a captar los satélites visibles. Se puede usar cualquiera de los
canales del receptor para captar las sefiales GPS, GLONASS o
GALILEO. El nimero de canales disponibles permite al receptor
captar todos los satélites GNSS a la vista en cualquier momento y
posicién.

El equipo esta dotado de una antena GNSS externa equipada con un
amplificador de bajo nivel de ruido (LNA) y el dispositivo de
radiofrecuencia (RF) del receptor conectados mediante un cable
coaxial. La sefial de banda ancha recibida se convierte, filtra, digitaliza
y se asigna a los diferentes canales. El procesador del receptor controla
el proceso de seguimiento de la sefial.

Cuando la sefial se fija en el canal, se desmodula y se miden los
parametros necesarios de la sefial (fases de portadora y de cédigo).
Asimismo, los datos de navegacidn emitidos se recuperan del marco
de navegacion.

Cuando el receptor capta cuatro o mas satélites, se calcula su posicion
absoluta en WGS-84 vy la diferencia de tiempo entre el reloj del
receptor y la hora GPS. Esta informacion y los datos de medicidn se
pueden guardar en la tarjeta CF opcional y descargar mas tarde en un
ordenador, y procesarse posteriormente mediante un paquete de
software de postproceso. Cuando el receptor funciona en modo RTK
se pueden registrar también en la memoria CF del receptor las
mediciones de datos brutos. Ello permite al operador comprobar por
partida doble los resultados en tiempo real obtenidos en el campo.

Dependiendo de las opciones elegidas, el receptor puede incluir las
siguientes funciones:

» Reduccién de multicamino.
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Sistemas de aumento basados en satélites (WAAS, EGNOS,
etc.).

Parametros de bucle de enganche de fase ajustable (PLL) y de
bucle de enganche de retardo (DLL).

Modos bifrecuencia o multifrecuencia, incluidos los modos de
levantamiento cinematico, cinematico en tiempo real (RTK) y
GPS diferencial (DGPS) (el DGPS incluye los modos estatico,
cinematico y RTK).

1PPS e indicador de evento

Entrada externa del oscilador

Salida interna del oscilador de cristal
Conectividad Ethernet

Registro de datos automatico.

Varios ajustes de angulo de méascara
Varios parametros del levantamiento
Modos estéatico o dinamico.

Presentacion

La configuracion de hardware estandar de NET-G3 incluye:
un receptor GNSS de 72 * un puerto de antena GPS
canales externa
cuatro puertos de datos serie * un puerto de entrada de
puerto USB y puerto frecuencia externa
Ethernet * puerto 1PPS y puerto del
un interfaz para controlar y indicador de evento

visualizar el registro de datos ¢ dos puertos de alimentacion
una ranura para tarjeta CF

Aunque ésta es la configuracién estandar, el OAF debe habilitar
algunas de estas funciones para un funcionamiento correcto. Para
ampliar informacién consulte “Archivo de autorizacion de opciones
(OAF)” en la pagina 1-20.
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El kit estdndar NET-G3 incluye el receptor NET-G3, un juego de
cables, fuente de alimentacion, CD de software Topcon GPS+, tarjeta
CF y documentacion.

Receptor NET-G3

El avanzado y compacto disefio de funciones del receptor NET-G3
proporciona una mayor versatilidad, fiabilidad y eficacia para
implementar una infraestructura de redes rentable y productiva de
manera puntual. Gestionado con el lenguaje de interfaz de receptor
GPS (GRIL) y equipado con diversos interfaces de hardware, este
receptor ofrece una flexibilidad indiscutida en ambas direcciones:

 Flexibilidad en las aplicaciones de software que pueden
controlar y monitorizar el comportamiento del receptor,
incluyendo PC-CDU y TopNET, asi como las aplicaciones
escritas por el usuario.

 Flexibilidad en el interfaz fisico usado para conectar el receptor
con diversos dispositivos externos, incluyendo ordenadores,
dispositivos de red, diversos sensores, fuentes de frecuencias,
etc.

MINTER

La MINTER es la interfaz minima del receptor que se emplea para
presentar y controlar la entrada y salida de datos (Figura 1-2 en la
pagina 1-10).

El LED STAT muestra el estado de los satélites que se estan
recibiendo.

* Rojo intermitente: el receptor esta encendido, pero no se esta
recibiendo ningun satélite.

» Verde intermitente: el receptor esta encendido y se estan
recibiendo satélites; un destello por cada satélite GPS que se
esta recibiendo.

» Naranja intermitente: el receptor esta encendido y se estan
recibiendo satélites; un destello por cada satélite GLONASS
gue se esta recibiendo.
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El LED de ENLACE muestra el estado de la conexién Ethernet.

* Luz verde fija— Se ha establecido una conexion Ethernet valida
con un dispositivo activo de la red.

* Desactivado — No hay ninguna conexion Ethernet establecida.

LED de
LED STAT  LED LINK alimentacion  Boton de funcion

Botén de
encendido

LED REC LED RX/TX
Figura 1-2. MINTER de NET-G3

Los LED PWR (alimentacidn) muestran el estado de la alimentacion
para la alimentacion suministrada desde el puerto de alimentacion
correspondiente en el panel trasero.

 \erde fijo: el receptor acepta la alimentacion de una fuente de
alimentacion externa conectada al puerto PWR correspondiente,
y esta alimentacion esté dentro del rango de tension de
funcionamiento permitido (6-28 V CC).

« Amarillo fijo: el receptor acepta la alimentacion de una fuente
de alimentacion externa conectada al puerto PWR
correspondiente, y esta alimentacion esté dentro del rango de
tensién de funcionamiento permitido (6—-28 V CC), pero no se
esta utilizando para alimentar el receptor.

* Rojo fijo: se ha producido un fallo de alimentacion (con la
fuente de alimentacion conectada) o la alimentacién no se esta
suministrando al puerto PWR correspondiente. Para ampliar
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informacion consulte la Seccion “Problemas de alimentacion”
en la pagina 5-2.
ElI LED REC muestra el estado del registro de datos. Para ampliar
informacion sobre el comportamiento del LED REC cuando se usa el
botén de funciones, consulte el apartado “El botén FN” en la pagina 1-
11.

» Verde intermitente: cada destello indica que se estan
escribiendo datos en la tarjeta CF.

 Naranja fijo: indica que el receptor esta cambiando de modo.

* Naranja intermitente: indica que el receptor esta verificando su
sistema de archivos interno (después de borrar la memoria
NVRAM o cargar un nuevo firmware). Durante esta operacion,
el sistema de archivos no esté accesible para las aplicaciones de
la CDU (Control Display Unit — Unidad de Visualizacion y
Control-) ni para el registro de datos. Esta operacion puede
durar desde fracciones de segundo hasta algunos minutos,
dependiendo de las circunstancias y de la capacidad de la
memoria de la tarjeta CF.

* Rojo fijo: indica un estado de fallo en el receptor (memoria
llena, no hay ninguna tarjeta CF instalada, problemas de
hardware o archivo OAF inadecuado).

La Tabla 1-1 de la pagina 1-11 describe el estado del LED REC
cuando se usa el boton FN.

ElI LED RX TX muestra el estado del mddem de radio interno. En la
version actual, le LED esta desactivado y es retenido para futuras
actualizaciones.

El boton FN alterna entre los modos de informacién y los modos de
postproceso en el receptor, inicia y detiene el registro de datos y
cambia la velocidad de comunicacion del puerto serie a 9600. Para
ampliar informacion consulte la Seccion “Funcionamiento de la
MINTER” en la pagina 3-23.

La Tabla 1-1 describe el estado del LED REC cuando se usa el boton
FN.
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Tabla 1 - 1: Operaciones del boton FN y estado del LED REC

Boton FN LED REC Estado

Cuando el registro de datos esta desactivado y la tecla FN...

Sin luz No se estan registrando datos.
Naranja Prueba del sistema de archivos interno en
. intermitente curso.
Sin pulsar
Rojo No hay memoria disponible; problema de
hardware en el registro de datos; no hay
ninguna tarjeta CF.
Si el modo de la tecla FN es “LED blink mode switch”
Pulsado Naranja Suelte la tecla para cambiar el modo de
durante < 1 informacion.
segundo

Si el modo de la tecla FN es “Occupation mode switch”

Naranja Sin funcion.

Si el modo de la tecla FN es “LED blink mode switch”

Verde Suelte la tecla para iniciar el registro de
datos (modo de ocupacion de postproceso no

Pulsado de 1 a definido).

5 segundos Si el modo de la tecla FN es “Occupation mode switch”

Verde Suelte la tecla para iniciar el registro de
datos (modo de ocupacion de postproceso
cinematico o estatico).

Pulsadode5a | Rojo Suelte la tecla para cambiar la velocidad de
8 segundos comunicacion del puerto serie A a 9600 bps.
Pulsado Sin luz Sin funcién.

durante més de

8 segundos
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Tabla 1 - 1: Operaciones del boton FN y estado del LED REC (Continuacion)

Botén FN

LED REC

Estado

Cuando el registr

0 de datos esta desactivado y la tecla FN...

Rojo

No hay memoria disponible; problema de
hardware en el registro de datos.

Si el modo de la tecla FN es “LED blink mode switch”

Verde Ha comenzado el registro de datos (modo de
ocupacion de postproceso no definido).
Sin pulsar
Si el modo de la tecla FN es “Occupation mode switch”
Verde Ha comenzado el registro de datos (modo de
ocupacién de postproceso cinematico).
Naranja Ha comenzado el registro de datos (modo de
ocupacion de postproceso estatico).
Si el modo de la tecla FN es “LED blink mode switch”
Naranja Suelte la tecla para cambiar el modo de
Pulsado informacion.
durante < 1
segundo Si el modo de la tecla FN es “Occupation mode switch”
Naranja Suelte la tecla para alternar entre los modos
de postproceso estatico y cinematico.
Pulsadode 1a | Sinluz Suelte la tecla para detener el registro de
5 segundos datos.
Pulsadode5a | Rojo Suelte la tecla para cambiar la velocidad de
8 segundos comunicacion del puerto serie A a 9600 bps.
Pulsado Sin luz Sin funcion (el registro de datos sigue
durante méas de activado).
8 segundos

El boton de encendido permite encender y apagar el receptor.
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Puertos de datos y de alimentacion
El NET-G3 tiene puertos en ambos paneles, delantero y trasero.
El panel frontal tiene los dos puertos siguientes (Figura 1-3):

» Serie (MINI-SNAP de ODU de 7 patillas): se usa para
comunicacion entre el receptor y un dispositivo externo. Este es
el puerto serie A del receptor.

» Puerto USB (Mini-B): se usa para transferencia de datos a alta
velocidad y comunicacion entre el receptor y un dispositivo
externo. Este puerto est ubicado detras de la puerta.

Puerto serie  Puerto USB (detras de la puerta)

Figura 1-3. Puertos del panel frontal de NET-G3
El panel trasero tiene los diez puertos siguientes (Figura 1-4 en la
pagina 1-15):
» Puertos serie (Conector D-shell de 9 patillas): se usa para
comunicacién entre el receptor y un dispositivo externo.

 Puerto Ethernet (MINI-SNAP de ODU de 12 patillas): se usa
para conectar el receptor a una red.

» 1 puerto PPS (conector BNC): se usa para generar sefiales de un
impulso por segundo con un tiempo de referencia, periodo y
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desviacion programables. El impulso se sincroniza a un tiempo
de referencia especificado.

Puerto indicador de evento (conector BNC): se usa para
introducir un evento sincronizado con un tiempo de referencia
especificado.

Puerto de antena GPS (Tipo de conector N): se usa para detectar
sefiales GNSS.

Puerto de frecuencia externa (conector BNC): se usa para la
entrada de una frecuencia externa o la salida de una frecuencia
interna del receptor.

Puertos de alimentacion (MINI-SNAP de ODU de 5 patillas): se
usa para conectar el receptor a una fuente de alimentacion
externa.

Antena 1PPS Serie Alimentacion

SERIAL C
SERIAL D

@

= EXT
FREQ

1
P\R 7.

ooooo

-\
- \ \ \\/

Frecuencia externa Evento Serie Ethernet

Figura 1-4. Puertos del panel trasero de NET-G3

Ranura para la tarjeta CF

La ranura de la tarjeta CF (Compact Flash) esta situada en el panel
frontal bajo la puerta (Figura 1-5 en la pagina 1-16) y conecta una
tarjeta CF opcional a la tarjeta del receptor para proporcionar
memoria. Una vez instalada, la tarjeta CF se suele dejar en el interior
del receptor. Se puede acceder a los datos que se encuentran en la
tarjeta CF a través del puerto serie, USB, o Ethernet. Las tarjetas CF
se pueden adquirir en las tiendas de informaética locales. Consulte la
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Seccion “Tarjetas CF compatibles con el NET-G3” en la pagina A-15
para obtener una lista de las tarjetas CF probadas con éxito con el
NET-G3. Para otras tarjetas CF, pdngase en contacto con soporte TPS.

Botén de la ranura
para tarjetas N Z/

Ranura para la
tarjeta CF

Figura 1-5. Ranura para tarjetas CF de NET-G3

Agujeros de montaje

El receptor lleva cuatro agujeros de montaje en la parte inferior para
instalar tornillos #8-32 para un montaje permanente (Figura 1-6 en la
pagina 1-17). La instalacion del receptor utilizando los tornillos
evitara movimientos no deseados.
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Figura 1-6. Agujeros de montaje de
la parte inferior de NET-G3

Cables y fuente de alimentacion

El conjunto del NET-G3 incluye cables estandar de comunicacién y
alimentacion para configurar el receptor y proporcionarle una fuente
de alimentacion. La Tabla 1-2 detalla estos cables.

Tabla 1 - 2: Cables de conjunto del NET-G3

Descripcion del cable llustracién del cable

Cable USB

Conecta el receptor a un dispositivo
externo (controladora u ordenador)
para transferencia de datos a alta
velocidad y configuracion del
receptor.

n/p 14-008081-01.

También se puede adquirir en las
tiendas de informética locales.
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Tabla 1 - 2: Cables de conjunto del NET-G3 (Continuacién)

Descripcion del cable

llustracién del cable

Cable serie

Conecta el receptor a un dispositivo
externo (controladora u ordenador)
para transferencia de datos y
configuracion del receptor. El cuerpo
del conector es de color negro.

n/p 14-008005-03

Adaptador Ethernet

Conecta el receptor a un cable
Ethernet cruzado o recto para una
comunicacion en red.

n/p 14-008085-01

1PPS, Indicador de evento,
cable de entrada/salida de
frecuencia externa; conecta el
conector 1PPS, EVENT, 0 EXT FREQ
del receptor al conector
correspondiente del dispositivo
externo.

n/p 14-008010-01

Cable de médem nulo

Conecta el receptor con un dispositivo
externo (controladora u ordenador)
para transferencia de datos y
configuracion del receptor.

n/p 14-008086-01

También se puede adquirir en las
tiendas de informatica locales.

1-18

Manual del Operador de NET-G3




Presentacion

Tabla 1 - 2: Cables de conjunto del NET-G3 (Continuacién)

Descripcion del cable

llustracién del cable

Cable de alimentacién

Conecta la unidad de alimentacion a
una toma puesta a tierra.

n/p EE. UU. 14-008052-01
n/p Europa 14-008053-01

Unidad de alimentacion
Convierte la corriente alterna (CA)
que se suministra desde unas toma de
corriente eléctrica en corriente
continua (CC) para alimentar el
receptor.

Se conecta al receptor mediante el
cable de alimentacién del receptor
(consulte las secciones relacionadas
con la alimentacion en el Capitulo 2).
n/p 22-034101-01

Cable de alimentacidn del
receptor

Conecta el receptor y la unidad de
alimentacién mediante conectores
SAE. El cuerpo del conector es de
color rojo.

n/p 14-008016-03

Cable en espiral protegido con
fusibles

Conecta el cable de alimentacion del
receptor mediante conectores SAE con
una unidad de alimentacion
personalizada con hilos desnudos.

n/p 14-008094-01
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Otros accesorios en kit

Los accesorios estandar en el conjunto del NET-G3 incluyen una
memoria CF de 512 MB, un CD que contiene un software de
configuracion estandar Topcon GPS+ un fusible y la documentacion
del receptor.

Figura 1-7. Accesorios incluidos en el NET-G3

Para ampliar informacion sobre los accesorios opcionales y los
conjuntos disponibles para el NET-G3, pdngase en contacto con su
distribuidor Topcon local.

Archivo de autorizacion de
opciones (OAF)

Los sistemas de posicionamiento Topcon incluyen un archivo de
autorizacion de opciones (OAF) para activar las opciones especificas
adquiridas por el cliente. Un archivo de autorizacién de opciones
permite a los clientes personalizar y configurar el receptor de acuerdo
con sus necesidades particulares, adquiriendo Gnicamente las opciones
deseadas.

Generalmente todos los receptores se suministran con un archivo OAF
temporal, que puede utilizarse durante un periodo de tiempo
preestablecido. Al comprar el receptor, un nuevo OAF activa de forma
permanente las opciones adquiridas. Las opciones del receptor
permanecen intactas cuando se borra la NVRAM o cuando se reinicia
el receptor.

El OAF activa los tipos de funciones que se citan a continuacién. Si
desea una lista completa de las opciones disponibles y los detalles
correspondientes, visite el sitio web de TPS o consulte con su
distribuidor TPS.
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 Tipo de sefial (estandar L1; opcional L2, L5 GPS, GLONASS,
GALILEO).

 Tarjeta de memoria CF externa

* Frecuencia de actualizacion (estandar 1 Hz; opcional 5, 10 6 20
Hz).

* RTKalHz,5Hz, 10Hzy 20 Hz

» Entrada/Salida RTCM/CMR

e 1PPS

* Indicador de evento

» Entrada/salida de frecuencia

o Ethernet

e« FTP

» Reduccion de multicamino avanzada

« Sistema de aumento de area amplia (WAAS)
 Supervisién de integridad auténoma de receptor (RAIM)
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Notas:
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Capitulo 2

Preparacionpreviaa
la configuracion

El despliegue y funcionamiento con éxito de un sistema de estacion de
referencia con el receptor NET-G3 requiere una cuidadosa
planificacion del emplazamiento, estudios de viabilidad y una
adecuada configuracion del equipo. Estos factores son criticos para
optimizar el rendimiento del NET-G3 y para integrar el receptor
perfectamente en una red existente o para establecer una nueva red.

Una vez que se ha determinado la ubicacion del NET-G3, puede
empezar a instalar el hardware y el software necesarios para configurar
y mantener el NET-G3. Tras determinar la aplicacion, use el software
seleccionado para configurar el receptor para su aplicacion.
Finalmente, obtenga almanaques y efemérides para comenzar a
trabajar con el NET-G3 en la aplicacion prevista. Las secciones
siguientes describen estos pasos detalladamente:

» “Determinacion de la referencia Emplazamiento de la estacion”
en la pagina 2-2.

» “Instalacion del software Topcon” en la pagina 2-5.

» “Instalacion de la tarjeta CF” en la pagina 2-8.

» “Alimentacién del receptor” en la pagina 2-9.

e “Obtencidn de almanaques y efemérides” en la pagina 2-11.
» “Conexion del receptor a un ordenador” en la pagina 2-12.
« “Administracion de la alimentacion” en la pagina 2-21.



Preparacion previa a la configuracion

Determinacion de la referencia
Emplazamiento de la estacion

El emplazamiento en el que se instalara la estacion de referencia
requiere que el equipo del proyecto tome decisiones especificas con
antelacion acerca de los objetivos del proyecto y, por tanto de la
aplicacion. Una vez que se ha decidido la aplicacion y se han aclarado
los objetivos, una inspeccion del emplazamiento ayudara a determinar
las configuraciones de hardware y software especificas y otros
requisitos.

Para ampliar informacion acerca de la planificacion del
emplazamiento, visite la pdgina Web de UNAVCO (http://
facility.unavco.org/) para ver las directrices y sugerencias.

Consideracion de la aplicacion de la
estacion de referencia NET-G3

Antes de considerar tanto la ubicacidn fisica como la configuracion del
receptor, es necesario tomar varias decisiones acerca de la aplicacion
de la estacion de referencia. Estas decisiones afectan practicamente a
toda la planificacién del proyecto, inspeccion del emplazamiento,
configuracion de hardware y software asociadas, asi como a las
actividades de recogida de datos . Entre las cuestiones a considerar se
encuentran las siguientes:

* quien serd el usuario final y cudntos habra (los que acceden a
los datos, los que analizan los datos, etc.)

* (ué clase de enlaces de comunicacion se utilizaran
» qué clase de datos se requieren y qué formatos de datos

 donde es necesario colocar el receptor (basandose en los
emplazamientos disponibles y la aplicacion prevista)

» cbémo se utilizara el receptor: como una sola estacion de
referencia 0 como parte de una red

* cuénto tiempo durara el proyecto: un proyecto a corto plazo o a
largo plazo

Todos los miembros del equipo de proyecto tienen que tener una clara
comprension de la finalidad del proyecto, los objetivos, y la
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Determinacion de la referencia Emplazamiento de la estacion

aplicacién. Una vez que los objetivos de la aplicacion hayan sido
identificados, se pueden seleccionar unos emplazamientos
preliminares y luego reducirlo al emplazamiento méas adecuado.

Realizacion de una inspeccion del
emplazamiento para la estacion de
referencia NET-G3

Al determinar la ubicacién donde colocar el NET-G3, considere la
seguridad relativa de la ubicacion fisica tanto para el receptor como
para el personal. La instalacion y el funcionamiento correcto de la
estacion de referencia deben cumplir las directrices siguientes:

* Ubicacidn del emplazamiento y el receptor

El edificio debe tener una visidn clara del cielo sin objetos ni
superficies reflectantes en las proximidades.

La ubicacion del receptor debe ser en el interior, colocado sobre
una superficie plana (como una mesa o un estante estable), pro-
porcionar acceso libre a los paneles frontal y trasero del recep-
tor, y ser facil de alcanzar y manipular para las actividades de
mantenimiento.

» Conectividad del equipo y sistema de cableado de antena

El emplazamiento debe proporcionar unos tendidos adecuados
para la conexion de diversos equipos. Los cables no deben ser
discretos, pero faciles de mantener.

Para una adecuada conectividad y funcionalidad del equipo, use
Unicamente cables originales y especificos. Tome en considera-
cion las siguientes recomendaciones al conectar los dispositi-
VOS:

- Etiquete cada cable.
En todos los extremos de cables, fije un adhesivo con un
identificador del cable.

- No exceda las longitudes de cable estandar.
La longitud del cable no debe exceder la distancia maxima
especificada en las normas correspondientes a los cables
gue se estén utilizando.
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- Mantenga todos los conectores de cable libres de polvo,
suciedad y otros contaminantes.

- Si fabrica sus propios cables, aseglrese de que estén
adecuadamente engarzados.

- Verifique que ha conectado cada cable a su conectador de
acoplamiento y esta firmemente asentado.

La construccion de un sistema de cableado de antena es uno de
los componentes clave para el funcionamiento correcto de la
estacién de referencia —especialmente cuando se utiliza un
cable de antena de més de 30 metros de largo o se conectan
varias antenas al mismo receptor. Consulte las directrices para
la construccion de un sistema de cableado en la Seccion “Cons-
truccion de un sistema de cableado de antena” en la pagina 3-
16.

» Accesibilidad a la alimentacién

El emplazamiento debe proporcionar y cumplir las especifica-
ciones sobre alimentacion del receptor y demas equipos instala-
dos. El receptor debe tener acceso directo a una toma puesta a
tierra.

El NET-G3 esté disefiado para aceptar dos entradas de alimenta-
cion y cambiar automaticamente durante las fluctuaciones de
corriente para mantener el receptor operativo.

- PWR 1 se puede conectar a la alimentacion principal
usando la Fuente de alimentacion universal incluida con el
NET-G3.

- PWR 2 se puede conectar a cualquier fuente de
alimentacion de reserva capaz de suministrar de 6 a 28 V
CC (incluyendo una fuente de alimentacién
ininterrumpida).

En caso de interrupcion de la alimentacion principal, la unidad

cambiara automéaticamente de PWR 1 a PWR 2. Cuando se res-
tablezca la alimentacion en PWR 1, el NET-G3 revertira a PWR

1, manteniendo un funcionamiento continuo durante la interrup-

cién de la alimentacion.

» Control de temperatura y humedad
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Instalacién del software Topcon

El NET-G3 esté disefiado para soportar duros entornos en
campo y se puede usar como una estacion de referencia tempo-
ral o semipermanente, seglin se requiera. En las instalaciones
permanentes, se recomienda que el NET-G3 se instale en un
entorno mas protegido y controlado.

* Proteccion contra rayos y otras sobretensiones

Para protegerse contra las sobretensiones subitas de electrici-
dad, la instalacion de pararrayos, protectores de sobretension,
etc. le ayudaran a blinda el equipo electronicos de las descargas
eléctricas directas o indirectas. Consulte a un electricista titu-
lado sobre las recomendaciones y la instalacién.

Instalacion del software
Topcon

El CD de Topcon GPS+ incluye los siguientes programas de software
para configurar y mantener el receptor. Este software también esta
disponible en el sitio web de TPS para los usuarios registrados.

» PC-CDU e FLoader
version 2.1.16 o0 mas reciente version 1.0.07 o posterior

» Topcon Link
version 6,04 o posterior

Para instalar los programas desde el CD de GPS+, introduzca el CD en
la unidad de CD-ROM del ordenador. Si ha descargado los programas
del sitio web, extraiga los archivos correspondientes en una carpeta de
su disco duro. Consulte la documentacién de Topcon Link para
obtener mas informacion sobre la instalacion y el uso.

Si ha adquirido el paquete de software de la estacién de referencia
TopNET, consulte la documentacion correspondiente acerca de la
instalacion y el uso de este software, y sobre la configuracion del NET-
G3 usando TopNET.
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Instalacion de PC-CDU

PC-CDU™ es un producto de software completo de Windows®
disefiado para controlar receptores GPS+ desarrollado por Topcon
Positioning Systems. PC-CDU usa el lenguaje de interfaz de receptor
GPS (GRIL) para configurar diversos parametros del receptor y
diagnosticar su rendimiento. PC-CDU esta disponible gratuitamente
en el sitio Web de Topcon o en el CD de GPS+.

Los requisitos del ordenador para PC-CDU son: Windows® 98 o una
version posterior y un puerto RS-232C o USB. Use PC-CDU 02.01.16
0 una version posterior para configurar correctamente el receptor.

uso de PC-CDU consulte el Manual de referencia

Para ampliar informacion sobre la instalacion y el
@ de PC-CDU.

1. Cree una carpeta PC-CDU en su disco duro y ponga en ella el
archivo comprimido PC-CDU (obtenido en el sitio web o en el CD
de GPS+).

2. Vaya a la carpeta PC-CDU y haga doble clic en el archivo
comprimido PC-CDU.

3. Extraiga PCCDU.EXE vy el archivo *.dll asociado en la carpeta
PC-CDU (Figura 2-1).

4. Cree un acceso directo en el escritorio del ordenador para poder
acceder rapidamente a PC-CDU (Figura 2-1).

B pocdu EEIX
File Edt View Favortes Tools Help .
Qe - © ¥ SO seah |2 Fodens | [F-
address| ) Citopeonipeedu ~| B =
Folders X Name Size | Tyme Date Modfied

(@ Desktap | pccou vs.ze 854 KB WinZip File 1j5i2004 4:56 P11 g
) My Documents ) LFTACCES.WAD 6KB Virlualdsvic...  6/1j2000 6:39 P11
= 8 by Computer & pocnuExE 2,224 KB application 12/23/200% 5116 P @tn“

# L 3% Floppy (A1)
= e New Yohme (C:)
& (5 Documerks and Scttings
® ) Program Flles
1) quarantine
I TEMP
= I3 topeon
23 pecddu
15 unzpped
® [ WINDOWS
b €D Drive (D2)
# UL D Drive (E:) ~
p > < >

Figura 2-1. Extraccion del programa y
creacion de acceso directo
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Para desinstalar PC-CDU, vaya a la posicion del archivo *.exe.
Seleccione el archivo y pulse Delete.

Instalacion de FLoader

FLoader es un programa de carga de firmware para la tarjeta GPS
interna del receptor. FLoader esta disponible gratuitamente en el sitio
web de TPS o en el CD de GPS+.

Los requisitos del ordenador para FLoader son: Windows® 98 o una
version posterior y un puerto RS-232C. Use FLoader 1.0.07 0 una
version posterior para configurar correctamente el receptor.

1. Cree una carpeta FLoader en su disco duro y ponga en ella el
archivo comprimido FLoader (obtenido en el sitio web o en el CD
de GPS+).

2. Despléacese a la carpeta FLoader y haga doble clic en el archivo

comprimido FLoader.

Extraiga FLoader.exe en la carpeta FLoader (Figura 2-2).

4. Cree un acceso directo en el escritorio del ordenador para poder
acceder rapidamente a FLoader (Figura 2-2).

w

& floader L@@
File Edt View Favorites Tools Help .
Qe - © | Oseach |2 Fodens | [F-
Address 53 Ciitopcontfloader ~| B
Foldsre X Name Size | Tyme Date Modfied
B Destton ~| “Lfloader_sppazip | 234KB WinZip Fils 8/17/2005 2:17 PM g
Y —— ¥, Floader exe 524K Application 2/12/2002 5:49 P FL
= 4 My Computer E
DA are Fleedlr
= S New Wolume (C:)
i (5 Documerks and Schtings
® | Program Files
1) quarsntine
1) TEMP
= I3 topeon
I3 bteonf
3 Aoader
3 peedu
15 unzpped
# 15 WINDOWS b
< I >

Figura 2-2. Extraccion del programa y
creacion de acceso directo

Para desinstalar FLoader, vaya a la posicién del archivo *.exe file.
Seleccione el archivo y pulse Delete.

P/N 7010-0761 2-7



Preparacion previa a la configuracion

Instalacion de la tarjeta CF

Detrés de la puerta del panel frontal hay una ranura para la tarjeta CF
opcional. La tarjeta CF proporciona espacio de memoria para guardar
datos registrados. El paquete NET-G3 incluye una tarjeta CF de 512
MB o una tarjeta CF de 1 GB opcional. Las tarjetas CF también se
pueden adquirir en las tiendas de informatica locales.

Latarjeta CF tiene que instalarse antes de poner en marcha el NET-G3.
La puerta también proporciona un rapido acceso a la tarjeta para su
extraccion.

Para preservar la integridad de los datos, instale o
extraiga la tarjeta CF unicamente cuando el

receptor esté apagado.

Lo

Verifique que el receptor esta apagado.

2. Gire los dos tornillos de la puerta hacia la izquierda para abrir la
puerta.

3. Inserte con cuidado la tarjeta CF, con el lado de la etiqueta hacia

arriba, en la ranura de la tarjeta CF (Figura 2-3).

Boton de expulsion
Tarjeta CF

.
SN
<$

Inserte la tarjeta CF

Figura 2-3. Instalacion de la tarjeta CF

Asegurese de que el boton esté metido antes de
cerrar la puerta del receptor.

2-8 Manual del Operador de NET-G3



Instalacién del software Topcon

Al encender el receptor, la placa del receptor detectara la tarjeta CF y
estara lista para usarla cuando la necesite.

Para extraer la tarjeta CF, primero apague el receptor. Abra la puerta
del receptor y presione el pequefio botdn a la izquierda de la ranura de
la tarjeta. La tarjeta CF emergera.

Alimentacion del receptor

El receptor NET-G3 esté disefiado para conectar con fuentes de
alimentacion externas (Figura 2-4 en la pagina 2-10). Cuando
configure el receptor, tenga en cuenta los siguientes requisitos de
alimentacion:

» Nunca use un cable alargador con una fuente de alimentacién
permanente. Este tipo de instalacion puede crear un riesgo de
incendio.

» Use siempre una toma puesta a tierra.

« Use un protector contra sobretensiones para proteger los
dispositivos electronicos conectados.

ElI NET-G3 tiene dos puertos de alimentacion, y cualquiera de ellos se
puede usar para alimentar el receptor.

1. Conecte el cable de alimentacion a la unidad de alimentacion.

2. Conecte los conectores SAE al cable adaptador de alimentacion y
a la unidad de alimentacion.

3. Conecte el cable adaptador de alimentacion a un puerto PWR en el
panel trasero del receptor.

4. Enchufe la unidad de alimentacion a una toma de corriente libre.
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Ala toma de corriente
con puesta a tierra

Figura 2-4. Conexioén del NET-G3 a una fuente de alimentacion

Comprobacion del estado de la ali-
mentacion

Puede comprobar el estado de la alimentacion del receptor usando los
LED PWE o el software Topcon disponible. Los LED de alimentacion
del receptor indican los estados de la alimentacion siguientes:

 Verde fijo: la alimentacion de este puerto PWR esta dentro de
un rango aceptable (6-28 VV CC) y se esta utilizando para
alimentar el receptor.

» Amarillo fijo: la alimentacion de este puerto PWR esta dentro
de un rango aceptable (6-28 V CC), pero no se esté utilizando
para alimentar el receptor.

* Rojo fijo: se ha producido un fallo de alimentacion (con la
fuente de alimentacion conectada) o no hay alimentacion en este
puerto PWR. Para ampliar informacion consulte la Seccion
“Problemas de alimentacién” en la pagina 5-2.

Consulte el manual de software correspondiente para obtener mas
informacion sobre el modo de comprobar el estado de la alimentacion
mediante el software instalado.
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Obtencién de almanaques y efemérides

Encender y apagar el receptor

Para encender el receptor, mantenga pulsado el boton de encendido
hasta que destellen brevemente los LED.

Para apagar el receptor, mantenga pulsado el boton de encendido
durante mas de un segundo y menos de cuatro (hasta que se apaguen
los LED STAT y REC). Este retardo (aproximadamente un segundo)
evita que se pueda apagar el receptor por error.

Obtencion de almanaques y
efemeérides

Todo satélite emite un mensaje de navegacion gue incluye los
parametros de efemérides, el almanaque y otros datos del satélite. Los
parametros de efemérides describen el movimiento orbital del satélite,
y se emplean para predecir su posicién/trayectoria. El almanaque
proporciona la orbita aproximada (recorrido) del satélite que esta
transmitiendo, y de todos los demas satélites del mismo sistema.

» Los satélites GPS y GLONASS emiten los datos de efemérides
con una periodicidad de 30 segundos.

 Los satélites GPS emiten los datos de almanaque con una
periodicidad de 12,5 minutos. Los satélites GLONASS emiten
los datos de almanaque con una periodicidad de 2,5 minutos.

Si el receptor tiene un almanague, podra reducir considerablemente el
tiempo necesario para buscar y captar las sefiales de los satélites.

El receptor actualiza periédicamente el almanaque y las efemérides, y
guarda el almanaque mas reciente en su memoria de acceso aleatorio
no volatil (NVRAM).

1. Preparacion del receptor. La antena externa debe instalarse en una

ubicacion con una vision clara del cielo.

Encienda el receptor.

3. Espere aproximadamente 15 minutos para que el receptor obtenga
todos los datos de almanaque y efemérides de los satélites.

n
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Si después de transcurrir 15 minutos el receptor no
capta los satélites, borre la memoria NVRAM. Para

@ ampliar informacidn consulte “Borrado de la
memoria NVRAM?” en la pagina 4-12.

Seré necesario obtener o actualizar el almanaque y las efemérides
cuando se den las siguientes circunstancias:

* Si el receptor ha estado apagado durante mucho tiempo.

+ Si la Gltima posicion conocida del receptor, almacenada en la
NVRAM, difiere de la posicion presente en varios cientos de
Kilébmetros.

» Después de cargar un nuevo Archivo de Autorizacion de
Opciones (OAF).

» Después de cargar un nuevo firmware.

» Después de borrar la memoria NVRAM.

Conexion del receptor a un
ordenador

Cuando haya establecido una conexion entre el receptor y el ordenador
podré configurar el receptor y sus componentes, enviar instrucciones
al receptor y descargar archivos de la memoria del receptor. Después
de establecer una conexién fisica entre el ordenador y el receptor,
realizard una conexion mediante el software instalado (PC-CDU,
TopNET, etc.). Tanto el software PC-CDU como TopNET
proporcionan una interfaz que incluye diversas funciones de
configuracion, supervision y gestion del receptor. Otros software,
como FLoader, se utilizan para actualizar, mantener o configurar los
componentes de un receptor conectado.

El NET-G3 usa los siguientes tipos de conexiones con un ordenador:
* con un cable RS232

e con un cable USB; el controlador USB TPS debe estar instalado
en el ordenador
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Conexion del receptor a un ordenador

 con un cable Ethernet; el ordenador tiene que tener una tarjeta
de red y estar configurado con el protocolo TCP/IP

Establecimiento de una conexion
mediante cable RS232

Los pasos siguientes describen la conexion fisica del cable, el receptor
y el ordenador. La Seccion “Pardmetros de la conexién PC-CDU” en
la pagina 2-19 describe una conexion de software con el receptor.

1. Con el cable RS232, conecte el puerto serie de su ordenador
(generalmente COML1) al puerto serie del receptor (ODU o DE-9).
Use el puerto serie que le resulte mas cémodo ya que ambos son
iguales en cuanto a funcionalidad, simplemente requieren cables
diferentes.

2. Pulse los botones de encendido del receptor y el ordenador para
encenderlos.

Establecimiento de una conexion de
cable USB

Asegurese de que el ordenador tiene instalado el controlador USB de
TPS Los pasos siguientes describen la conexion fisica del cable, el
receptor y el ordenador. La Seccion “Pardmetros de la conexion PC-
CDU” en la péagina 2-19 describe una conexion de software con el
receptor.

1. Con el cable USB, conecte el puerto USB de su ordenador al
puerto USB del receptor situado detras de la puerta del panel
frontal.

2. Pulse los botones de encendido del receptor y el ordenador para
encenderlos.
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Puertos serie

Puerto USB

Figura 2-5. Puertos serie y USB de NET-G3

Establecimiento de una conexion
Ethernet

Asegurese de que los ajustes IP del receptor estan configurados antes
de conectar el receptor y el ordenador usando una conexion Ethernet.
Esta configuracion requieres conectar el receptor y el ordenador
usando un cable RS232 antes de conectarlos usando un cable Ethernet.
Consulte “Configuracion de una conexién Ethernet Usando PC-CDU”
en la pagina 2-15 para ampliar informacion.

NET-G3Yy el software asociado disponen de dos opciones de conexion
a Ethernet que utilizan un adaptador Ethernet del kit NET-G3 y un
cable Ethernet adquirido en una tienda de informatica:

* una conexion directa: requiere un cable cruzado Ethernet

* una conexion de red Ethernet TCP/IP existente: requiere un
cable Ethernet recto

Los pasos siguientes describen la conexidn fisica de los cables, el
receptor y el ordenador. La Seccion “Pardmetros de la conexion PC-
CDU” en la péagina 2-19 describe una conexion de software con el
receptor.

1. Inserte el conector de 12 patillas del adaptador Ethernet en el
puerto ETHR del receptor.
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2. Conecte el otro extremo de este adaptador a cualquiera de los
extremos del cable cruzado o recto Ethernet.

3. Conecte el segundo extremo del cable Ethernet al conector
Ethernet de la parte trasera del ordenador o a un concentrador o
conmutador de red.

Cable recto a un
concentrador de red

Cable cruzadN
al ordenador /

|\@

e

Figura 2-6. Conexion de un cable Ethernet

Configuracion de una conexion
Ethernet usando PC-CDU

Antes de usar la opcion Ethernet en un NET-G3, es preciso configurar
los ajustes para este método de conexidn. Necesitara los siguientes
componentes de hardware/software para usar una conexion Ethernet.

 un ordenador con una tarjeta Ethernet y el protocolo TCP/IP
configurado.

 la tltima version de PC-CDU.

* un receptor NET-G3 con un puerto Ethernet instalado y la
opcion del puerto Ethernet habilitada; para las conexiones de
red, la opcion de conexiones FTP habilitada. Consulte
“Administracion de opciones del receptor” en la pagina 4-8 para
comprobar las opciones del receptor.

* una conexion de red requiere una direccion IP estatica Unica
independientemente de que se utilice o no un Protocolo de
configuracion de host dinamico (DHCP) en la red, una méascara
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de subred y una puerta de enlace predeterminada para cada
receptor.

Cuando conecte los receptores TPS a una red,
@ trabaje estrechamente con el administrador del
sistema para garantizar una conexion correcta.

El procedimiento siguiente describe cdmo conectar el receptor a un
ordenador usando los puertos Ethernet y como configurar el receptor
para que sea reconocido en una red. El ejemplo de este procedimiento
usa un protocolo con los ajustes siguientes:

e |P address —192.168.0.1

» Gateway — 192.168.0.3 (para una conexion directa: si dos
dispositivos estan conectados directamente y no tienen
conexiones con otra red, la direccion de la puerta de enlace se
puede configurar como todo ceros)

* Subnet mask — 255.255.255.0

Ambos métodos de conexidn Ethernet estan incluidos en el
procedimiento siguiente.

Use una conexion Ethernet directa para probar la
a eficacia de este método de conexion antes de

RECOMENDACION

= conectarse a una red.

1. Conecte el receptor y el ordenador usando un cable RS232.
Consulte “Establecimiento de una conexion mediante cable
RS232” en la pagina 2-13 para ampliar informacion.

2. Inicie PC-CDU vy selecciones los siguientes parametros de
conexion. Haga clic en Connect.

» Connection Mode — Direct
» Port: el puerto serie que conecta el ordenador y el receptor

» Baud rate: la velocidad de comunicacién entre el ordenador
y el receptor (normalmente 115200)

Haga clic en Configuration » Receiver » Ports » Ethernet.
4. Seleccione los siguientes ajustes IP para el receptor (Figura 2-7 en
la pagina 2-18):

w
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Conexion del receptor a un ordenador

IP Address: introduzca el mismo valor que la direccion IP
del ordenador, pero incremente el Gltimo ndmero en uno. El
ultimo nimero debe diferir de la direccion IP del ordenador
pero dentro de un rango de 0 a 255 (por ejemplo,
192.168.0.2).

IP Mask: introduzca el mismo nimero usado para el
ordenador.

Gateway: introduzca el mismo nimero usado para el
ordenador.

5. En el rea Telnet Settings, deje todos los ajustes como
predeterminados, pero asegurese de que el puerto TCP se fija a
8002 (Figura 2-7 en la pagina 2-18).

TCP port — 8002 (valor predeterminado). Este es el puerto
donde el receptor escucha las conexiones del tipo de Telnet.
El receptor permite hasta cinco conexiones del tipo Telnet
simultaneas.

Timeout — 600 (valor predeterminado). Este parametro
establece la cantidad de tiempo en segundos que el receptor
permite que una conexién inactiva permanezca abierta.
Después de este tiempo, el receptor cierra la conexion no
utilizada.

6. Para las conexiones de red, configure los ajustes de FTP
(opcional) con las selecciones siguientes (Figura 2-7 en la
pagina 2-18):

TCP port — 21 (valor predeterminado). Este es el puerto
donde el receptor escucha la conexion FTP. El receptor sélo
permite una conexion FTP a la vez.

Timeout — 600 (valor predeterminado). Este pardmetro
establece la longitud de tiempo en segundos que el receptor
permite que una conexién inactiva permanezca abierta.
Después de este tiempo, el receptor cierra la conexién no
utilizada.

7. Si se requiere, introduzca una Network Password para acceder al
servidor FTP (Figura 2-7 en la pagina 2-18).
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Bmerall MINTERI Pﬂsil'nn'ngl Base I Rover x; 1 Evams] Advancedl

Serial | Parallel | Modem | USE  Ethemet | TcP |

‘ ‘Warning. Newly applied settings will be activated only after receiver reset.

~IPSettings—— [ TelnetSetings————— FTPSetings————————————
IP Address: |T 92168.0.2 TCP Port:  |5002 TCP Part: |21
IP Mask: |255-255-255-U Timeout [s}  |600 Timeout [s}: (600

Galeway  [15216803

Metwork Password: I

Refresh Apply
__Refish_|

0K I Exit I Save I Sutalparametemludefmltsl

[

Figura 2-7. Ajustes de la conexion Ethernet -
Ejemplo de la red FTP

8. Haga clic en Apply y luego en OK para configurar los parametros.

9. Haga clic en Tools » Reset receiver para reiniciar el receptor.

10.Haga clic en File » Disconnect.

11.Conecte el receptor y el ordenador o un dispositivo de red
(concentrador, conmutador, etc.) segun se describe en
“Establecimiento de una conexion Ethernet” en la pagina 2-14.
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Parametros de la conexion PC-CDU

Cuando se conecte al receptor através de PC-CDU, el tipo de conexion
determina los pardmetros a seleccionar. La Tabla 2-1 y la Tabla 2-2
enumeran los parametros para los cuatro tipos de conexion.

Tabla 2 - 1: Parametros de la conexién PC-CDU para RS232 y USB

Parametro RS232 usB

Connection

Mode Direct

Puerto que conecta el
ordenador y el receptor
(normalmente COM1, COM2
para RS232)

Port usSB

Velocidad de comunicacion
Baud Rate entre el receptor y el ordenador| n/a
(normalmente 115200)

Numero de identificacion del

Rec ID n/a
receptor
RS232
x|
[~ Connection moder
(= Direct " Intemet Client " Intemet Server ‘
Port settings ‘ USB
Part: |COM?1 ¥| Baudrate: |115200 ¥ [ —
i L e L x
I~ RT5/CTS handshaking = s
1~ Program settings & Dieck € Intermet Client  Intemet Server
[~ Passivemode [ Manual mode only ~Port settings
™ Restore the receiver's original baud rate on Disconnect Port: |USB LI Rec [D: |BPAZKEBA1KW LI O s
1 Intemet settings
Host rae: flocalhost TCR ¢
—Pragram setting:
Rassiord | I~ Passivemode | Manualmode only,  Timeout [ms]. {500 E
I Display detacnisever. ¥ Log seiver events | = Restore the receiver's original baud rate on Disconnect
Connect I Cancel 1~ Intemet [ Client - Server ) settings
Host rame; [localhost TICP port |'r'r
assWord I
[~ Display data onserver |9 Log server evert [~ DNS lackup
Connect I Cancel |

Figura 2-8. Ajustes de la conexion PC-CDU - RS232 y USB
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Tabla 2 - 2: Parametros de conexion PC-CDU para Ethernet

Parametro Directa Red
Connection .
Direct
Mode
Port ETHR
TCP port 8002 (predeterminado)
Host name Direccion IP asignada al receptor
Asignada durante la
Password n/a . .
configuracién inicial
Connection mode:
‘ & Direct ¢ |nternet Client " Intemet Server ‘
[ Port setting:
Poit [ETHR =] Hostname: [19216802
TCP port: (8002 Pauwold:l
[ Program settings
[¥ Passivamode [~ Manualmodeonly  Timeout [ms] IG[D -
™ Restore the receiver's original baud rate on Disconnect
[Intemet [ Client - Server ) settings
Host r.-m--|r.' 105.138.105 TCP pot: |'n'n
¥ Display data oriserver [ Log server events I~ DNS lookup
Cancel
Figura 2-9. Ajustes de la conexiéon PC-CDU -
Ethernet (Ejemplo directo)
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Administracién de la alimentacion

Administracion de la
alimentacion

El software PC-CDU de Topcon proporciona una interfaz que incluye
diversas funciones de configuracion, supervision y gestion del
receptor. Para administrar la alimentacion del receptor, PC-CDU
muestra la tension actual de la fuente de alimentacion.

1. Conecte su receptor a un ordenador. Este procedimiento se explica
en la seccion “Conexion del receptor a un ordenador” en la
pagina 2-12.
Una vez conectado, haga clic en Configuration » Receiver.
3. Consulte la informacion sobre Voltages (Figura 2-10).

“On Board” muestra la tension de la tarjeta del receptor.

n

Voltages [volts)

Extemal :
OnBoard:

11T

¥ Enabie Low Fowes Mode

ok Exit Sove | Set o paremeters 1o detouts

Figura 2-10. Visualizacion de la informacion de tensiones
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Notas:
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Capitulo 3

Configuracion e
instalacion de NET-
G3 para
levantamiento
topografico

El NET-G3 esta concebido principalmente para su uso como una
estacion de referencia GNSS permanente o semipermanente para
establecer redes que presten apoyo a aplicaciones en tiempo real asi
como de posproceso. Los datos de la observacion se pueden transmitir
a través de cualquier puerto a cualquier dispositivo capaz de recibirlos
y utilizarlos, incluido el software de la estacion de referencia TOpNET.
Los datos también se pueden registrar internamente a unas tarjetas CF
extraibles para descargarlos y prestar apoyo a aplicaciones de
levantamiento estatico o cinematico, representacion grafica, vigilancia
y posicionamiento.

EI NET-G3 es configurable para uno o varios escenarios, incluidos los
siguientes:

* estacion de referencia permanente y semipermanente
« estacion de referencia temporal (o receptor de camparia)

 equipo movil RTK o DGPS (para vigilar una ubicacién fija,
vigilancia de sistemas, u obtencion de datos moviles)

Este capitulo contiene informacion sobre la configuracion béasica del
NET-G3 para algunas de estas aplicaciones. EI manual de PC-CDU
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contiene informacion de configuracién adicional, al igual que los
manuales del software TopNET.

Independientemente de las aplicaciones previstas o el software de
configuracion, la configuracién basica del NET-G3 incluye los pasos
siguientes:

“Configuracion del receptor” en la pagina 3-2.
 “Configuracion de la MINTER” en la péagina 3-8.

» “Instalacion del receptor como estacion de referencia temporal”
en la pagina 3-17.

» “Levantamiento estatico para estaciones de referencia” en la
pagina 3-22.

Configuracion del receptor

Generalmente, el NET-G3 se configura como una estacién de
referencia estatica que recopila informacion de mediciones GNSS y
registra los datos internamente a una tarjeta CF extraible, transmite los
datos a un ordenador central y, posiblemente, se conecta directamente
a uno o mas radios (o cualquier combinacién de estas
configuraciones). Los programas de software PC-CDU y TopNET de
Topcon se utilizan para gestionar y configurar las distintas funciones
del receptor. Los ajustes de configuracion se guardan en la memoria
interna de la placa del receptor GNSS y se reflejaran cuando se use la
MINTER.

La informacién completa de configuracion y funcionamiento de PC-
CDU y de TopNET sobrepasan el alcance del presente manual. Para
ampliar informacion acerca de cualquier procedimiento de esta
seccion, o sobre PC-CDU o TopNET, consulte el manual
correspondiente disponible de Topcon.

Cuando haya establecido una conexion entre el receptor y el ordenador
podra:

« configurar el receptor y sus componentes;
* enviar instrucciones al receptor;
* descargar archivos de la memoria del receptor;

* cargar un nuevo archivo OAF y otros archivos de configuracion
en el receptor.
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Configuracién del receptor

A continuacién se da un ejemplo de una configuracién del NET-G3
como una estacién de referencia que admite el registro de datos
internos y apoya a una unidad mavil en tiempo real usando una radio
para la transmision de los datos de correccién GNSS. Esta
configuracion usa PC-CDU para aplicar los parametros
correspondientes.

No introduzca ningln otro cambio sin consultar el
Manual de referencia de PC-CDU.

1. Conecte el receptor a un ordenador usando uno de los métodos
descritos en “Conexion del receptor a un ordenador” en la
pagina 2-12.

2. Inicie PC-CDU y conéctelo al receptor de acuerdo con los ajustes
descritos en “Pardmetros de la conexion PC-CDU” en la pagina 2-
19.

Una vez establecida una conexién PC-CDU con el receptor se
mostrara en la esquina inferior izquierda de la pantalla principal de
PC-CDU la configuracién de comunicaciones actual, como el hombre
del puerto, la velocidad de comunicacion (si corresponde), y el control
de flujo (si corresponde). Asimismo, en la esquina inferior derecha, un
reloj comenzara a contar el tiempo (Figura 3-1).

E PC-CDU to NET-G3 ID:QBPTRF 12KEW
Fie Configuratibn Tools Plots Help
GPS Satellitas (10) Gen vz | Temer | GLONASS Satellites (2)

# | EL[ azf[ca[m]pe[ec] Tl ss[ Lot 3742 10.9869'N sn[Fn [ EL] az[ca[m[refec] 1c] 58

14 9 1e8 40 18 16 1 3 on  eom IZVARORSODMM TR e T T w3 on
Alt 1576316 m

0B - 128 47 ¥ /N 23 03 206 36 3/ 2 2 16

i
Vel 00132 mfs
05 14 34 A0 TP A7 0 e Ec 3900
1 19- B 44 23 23 71 A

3

2

B 00 Bhs el 00111 mds
17 B0+ 1724 49 4 45 533 00+ FpAm 44709
24 14+ 162 41 2 2 "M 300+ (standalone)
3
1
3
3

43 20 A6 ;¥ I/ M
7 14 13 4w M
2 6 48 43 ¥ 1M
29 4% P60 47 3/ 3B 77

00 Fieceivertime 227565
e Pheceer datedf27/2006
Clack oftzet. +0.0318 ppm
Oscoofiset. 04952 ppm
Tracking tima: 000333

GO, 115200 00:03:32

Figura 3-1. Conexion con PC-CDU establecida

3. Haga clic en Configuration » Receiver.

P/N 7010-0761 3-3



Configuracion e instalacion de NET-G3 para levantamiento topogréafico

<

Después de introducir cualquier cambio en la
configuracion haga clic en Apply; de lo contrario,
el receptor no registrara el cambio.

4. Haga clic en Set all parameters to defaults (Figura 3-2).

w1od | MINTER | Possionng | Bese | Rover | Ports

.

Set all paramelerL\QU defaults |

Figura 3-2. Boton Set All Parameters to Defaults Configuracion
e instalacion de NET-G3 para levantamiento topografico

5. Hagaclic en la pestafia MINTER y configure los ajustes siguientes
(Tabla 3-1), a continuacion haga clic en Apply (Figura 3-3 en la
pagina 3-5).

Tabla 3 - 1: Parametros del receptor en la pestana MINTER

Parametro

Ajuste

Recording interval

Introduzca 15 segundos.

Elevation mask angle

Introduzca 15 grados.

File name prefix:

Introduzca las 3 Gltimas cifras del nimero de serie del
receptor.

FN key mode

(inicia y detiene el registro de datos mediante la tecla
FN)

Para registro de datos estéticos seleccione LED blink
mode switch.

3-4
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Lol Receiver Contigueation T

X Xl

Goned MINTEH | Pustonng | Bave | Ro | Pots | Events | Advarced |

Flecording sl [0 fsecondi] 14 ke mode

Flesention moseh {1 g e 3 [degeei) & LED bk e switch 1™ Occupation mode swich

[p——— [k Il data cchechon dynatat

2 apguerad [ =

Fies Comstin ke Dot recontig mav-stast

& Logh  asam G on Con o

Auomatec: i Fctlion Mods VM) pas meters

[
Recording interval : 1.00 [seconds) FN key mode
) % LED blink mode switch
Elevation mask for Log file: ~ [15 [degrees]
File name prefix : log
Hehech [
0K |G | Save | Setalpaamess to detacks

Figura 3-3. Configuracion de la MINTER para registro
de datos estaticos
6.

Haga clic en la pestafia Positioning y ajuste Elevation mask a 15
(Figura 3-4), a continuacion haga clic en Apply.

Elevation mask l_
[degres) : 15
pom F oped
Rahwah
: Ext Save | Setal porsmetin © detubs

Figura 3-4. Configuracion de posicionamiento del
receptor. Mascara de elevacion
7. Haga clic en la pestafia Base y ajuste los parametros siguientes
(Figura 3-5 en la pagina 3-6), a continuacion haga clic en Apply.
» GPS/GLO at one time. Activar.

» Antenna position. Introduzca los valores Lat, Lon, y Alt
mediante uno de los siguientes métodos:

- Si los conoce, introduzca los valores.

Active Averaged, introduzca el intervalo medio en segundos
y haga clic en Apply. Haga clic en Tools » Reset receiver y
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espere hasta que se complete el intervalo especificado.
Examine las coordenadas del equipo base en la pestafia
Base. Deberian corresponder a las coordenadas obtenidas de
la media. Si las coordenadas tienen valor cero, haga clic en
Refresh.

- Haga clic en Get from receiver.

pestafia corresponden al centro de fase L1 de la

Las coordenadas geograficas especificadas en esta
@ antena.

Continte en el paso 8 para levantamientos RTK o en el paso 9 de la
pagina 3-7 para otras configuraciones.

® Prese Center L]

Lat: IS_‘IF' 1097753 "N »| Getfromreceiver| F—0 = =

Lon: [121 <[42 *[750060 " [w =
Alt 1160 4666

Figura 3-5. Configuracion del equipo base
8. Paralevantamientos RTK, haga clic en la pestafa Ports y ajuste los
siguientes parametros del puerto serie (Tabla 3-2); a continuacién
haga clic en Apply (Figura 3-6 en la pagina 3-7).

En levantamientos con postproceso mantenga los
valores predeterminados de estos parametros.
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Tabla 3 - 2: Parametros del receptor en la pestana Ports

Parametro Receptor base
Input n/a (mantenga el valor predeterminado, “Command”.).
leccione el ti | form |
Output Seleccione el tipo y el formato de las

correcciones diferenciales.

Period (sec)

Introduzca el intervalo con el que el receptor transmitird las
correcciones diferenciales.

Seleccione la velocidad de comunicacion que se usara para
transmitir mensajes diferenciales de la tarjeta del receptor al

Baud rate . . - o .
maodulo de médem. La velocidad de comunicacién debera
corresponder a la velocidad del puerto serie del modem.

RTS/CTS Seleccione este pardmetro para activar el protocolo de enlace.

Eif Recwiven Conlfigusation
Genessi | MINTER | Potitoong | Base | Aover Pors | Evers | Advanced |
Sowl | Pastel | Moden| USE | Ethenst| TCP |
Sailh Ired = Bl 1aln s
oupt [T 7] e [T r
Smup " Carmmared * Dadime: 11500 ¥
i |None > Pedodisl: ™ RISATS
AT Conmand - Baudrotn: [ 0400 7|
JJom =] Pewdnl @  RISAIS
SoldD gt [Commard = pnstron [T15200 =] |||
I vhowed Ougar: [feee =] Ressd [  RTS/CTS
e )
; Input - IE':'F”"“B"‘j j' Baud rate : | 33400 'l
Senal C
Output: |CMR el Period (5] |W.DU ¥ RTS/CTS

Figura 3-6. Configuracion del equipo base
para levantamientos RTK. Puertos

9. Haga clic en la pestafia Advanced y a continuacion en la pestafia
Multipath. Ajustes los pardmetros siguientes y haga clic en Apply

(Figura 3-7 en la pagina 3-8).
» Code multipath reduction. Activar.
 Carrier multipath reduction. Activar.
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X

Gl | MINTER | Postonng | Base | Rors | Pots | Evends Advaress |
ArbrIntederersn Muipsth Redustion | Lo Momagered | Etrand Frospaercy | R Dok Marwogeossen | Dghons |

[ Coce mubputh imhucion
I L rndbgiath smchactor|

[V Code multipath reduction
v i

ey Aot

0K f Dt Sove | Set ol parametert o defauks

Figura 3-7. Configuracion de parametros de multicamino
10.Haga clic en OK para guardar los ajustes y cerrar el cuadro de
diédlogo.
Cuando haya configurado el receptor, la configuracion se manten-
dra hasta que la cambie, bien mediante el programa PC-CDU o
borrando la NVRAM.

Si desea ampliar informacion acerca de las posibilidades de con-
figuracion de los equipos base y movil, consulte el Manual de ref-
erencia de PC-CDU.

11.Siga con las demas actividades de configuracién o haga clic en
File » Disconnect, y a continuacion en File » Exit para salir de
PC-CDU.

La desconexion antes de salir garantiza una gestion del puerto ade-
cuada.

Desconecte el receptor de PC-CDU antes de salir

@ para evitar posibles conflictos con la
administracion de los puertos serie del ordenador.

Configuracion de la MINTER

La interfaz minima (MINTER) se compone de dos teclas (encendido y
FN) que controlan el funcionamiento del receptor, cuatro LED que
muestran el estado de funcionamiento del receptor, y dos LED que
muestran el estado de la alimentacion (Figura 3-8 en la pagina 3-9).
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LED de
LED STAT LED LINK alimentacion  Botén de funcion

Boton de
encendido

LED REC LED RX/TX
Figura 3-8. MINTER

La MINTER permite ejecutar las siguientes funciones. Para ampliar
informacion sobre el uso de la MINTER consulte la Seccion
“Funcionamiento de la MINTER” en la pagina 3-23.

» Encender y apagar el receptor y ponerlo en modo de espera.
 Activar o desactivar el registro de datos (tecla FN).
» Cambiar el modo de informacion del receptor.

* Mostrar el nimero de satélites GPS (verde) y GLONASS
(naranja) que se estan recibiendo (LED STAT).

* Mostrar el estado del registro de datos (LED REC).

» Mostrar cada vez que se registran los datos en la memoria
interna (LED REC).

» Mostrar el estado del modo de postproceso (estatico o
dindmico) cuando se lleva a cabo un levantamiento cinematico
con postproceso con ayuda de la tecla FN (LED REC).

» Mostrar el estado de la alimentacién del receptor (LED PWR).

Utilice PC-CDU para configurar la MINTER. El procedimiento
siguiente describe los ajustes mas comunes; para consultar otras

P/N 7010-0761 3-9



Configuracion e instalacion de NET-G3 para levantamiento topogréafico

configuraciones posibles de la MINTER remitase al Manual de
referencia de PC-CDU.

1. Conecte su receptor a un ordenador. Este procedimiento se explica
en la seccion “Conexion del receptor a un ordenador” en la
pagina 2-12.

2. Enel cuadro de didlogo Connection Parameters, marque la casilla
RTS/CTS handshaking (Figura 3-9).

Consulte “Parametros de la conexion PC-CDU” en la pagina 2-19
para mas detalles sobre el ajuste de otros parametros.

3. Haga clic en Connect.

[ Connection Palamzteis
Conrection mode:
& Diract € Intamat Cliant € Interrat Sarvar

[ Fart setting

Fort: | COM1 - Eaud rate: | 116200 v | [ Infrared pot

[¥ RTS/CTS handshaking

Pregram :eting /
’Vr Passivemode [ {malmudzurw Timsout gl [500 |+

nanal baue rate on Disconrect

[v RTS/CTS handshaking pe—

Pasenord: |

[ Displa dataon corver [#) Loc sarverovents | BHS clap

TER pit] 000

Figura 3-9. Parametros de conexion.
Ajustes de la MINTER

4. Haga clic en Configuration » Receiver y a continuacion en la
pestafia MINTER; ajuste los siguientes parametros y haga clic en
Apply (Figura 3-10 en la pagina 3-11). En las paginas siguientes
podréa consultar la descripcion de estos parametros.

» Recording Interval en la pagina 3-11.

 Elevation Mask for Log File en la pagina 3-11.

* File Name Prefix en la pagina 3-11.

 Always Append to the File en la pagina 3-12.

* Files Creation Mode en la pagina 3-12.

» Automatic File Rotation Mode (AFRM) en la pagina 3-12.
* FN Key Mode. en la pagina 3-13.

« Initial Data Collection Dynamic Mode en la pagina 3-14.
» Data Recording Auto-start en la pagina 3-14.
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[ Receiver Configuration x|

Gieneral MINTER | Posifoning | Base | Fiover | Forts | Events | Advanced |

Fecarding irtervd 100 [seconds) FM ey mode
Bevaltinmeck fo Loglle:  [5 dsaress) [r-‘ LED blink mads switch ¢ Oscupation node switch

Fig name prefix Icg Initial data colection dynamic mods
T e— | Irri‘ Stats 0 Kinematic
Deka recording aute-star
AFRM |Vf;' off  ln 1 Aluays

Filez Creaticn mod

|7(3‘ Log file (ol

Automatic Fl Fotation Mads [AFAM) paramsters———

Periad fser]f 3600 Files (tatall [0
[hase fsec]: [0 File: (remain] |0

™| Automatalliemove ol files

Retesh | dopy |

Exit Save | Setallparametsrs to defaults |
I

Figura 3-10. Configuracion del receptor. Pestaina MINTER

Recording Interval Este pardmetro especifica el intervalo de salida
de mensaje en el archivo de registro cuando la tecla FN de la interfaz
MINTER activa el registro de datos (pulse la tecla de 1 a 5 segundos).
Este ajuste se utiliza tanto para registrar un archivo de registro simple
como para registrar datos del receptor en el modo AFRM. Los valores
van de 1 a 86400 segundos. El valor por defecto es un segundo.

Elevation Mask for Log File Este parametro especifica el &ngulo de
elevacién minimo de los satélites cuyos datos se registraran en los
archivos del receptor al pulsar la tecla FN. El valor predeterminado es
cinco grados.

File Name Prefix Este pardmetro especifica el prefijo que se afiade a
los nombres de los archivos del receptor que se crean al pulsar la tecla
FN. El prefijo puede tener una longitud de hasta 20 caracteres. El valor
por defecto del prefijo de nombre de archivo es “log”.

Los nombres de archivo de registro tienen la siguiente estructura:
<prefijo><mes><dia><letra secuencial del alfabeto>

El nombre de archivo depende del momento de creacion del archivo
(mes y dia) y de los sufijos alfabéticos que se afiaden para evitar
confusiones entre archivos creados el mismo dia.
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Always Append to the File Si desea gque se adjunten nuevos datos
del receptor a un archivo de registro existente, introduzca el nombre
del archivo deseado en este pardmetro. Este parametro puede tener una
longitud de hasta 20 caracteres.

Files Creation Mode Este pardmetro tiene los siguientes modos de
operacion:
 Log file. Si se ha seleccionado el boton de opcién de archivo de
registro, al pulsar la tecla FN se cierra el archivo de registro
actual. Si el registro de datos esta desactivado, al pulsar la tecla
FN se abre un nuevo archivo de registro.

» AFRM. Si se ha seleccionado el boton de opcion AFRM, al
pulsar la tecla FN se habilita este modo. Si se ha habilitado
AFRM, al pulsar la tecla FN se deshabilita este modo.

Automatic File Rotation Mode (AFRM) Los receptores TPS son
capaces de rotar automéaticamente los archivos de registro. Durante un
evento de “rotacion de archivos”, el receptor cierra el archivo actual y
abre uno nuevo de acuerdo con un programa definido por el usuario.
Los pardmetros Period y Phase definen este programa. La rotacion de
archivos se lanza en el momento en que el Periodo del madulo horario
del receptor es igual a la Fase. De forma maés precisa, inmediatamente
después de la época programada se abre un nuevo archivo de registro,
provocando que los datos identificados con esta época se registren en
el nuevo archivo de registro.

Cuando se abre un nuevo archivo de registro, el receptor habilita el
conjunto de mensajes por defecto obtenido con el periodo de salida por
defecto. Se pueden programar tanto el conjunto de mensajes por
defecto como el periodo de salida por defecto.

 Period. Especifica la duracion de tiempo de cada archivo de
registro creado en modo AFRM. Los valores van de 60 a 86400
segundos. El valor por defecto es de 3600 segundos.

» Phase. Especifica la “fase” (diferencia de tiempo constante) de
creacion de archivos de registro multiples en modo AFRM. Los
valores van de 0 a 86400 segundos. El valor por defecto es cero
segundos.

* Files (total). Un contador que especifica cuantos archivos de
registro multiples se deberan crear en AFRM hasta que este
modo se desactive automéaticamente. Este contador decrece con
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cada rotacion de archivos hasta que el valor llega a cero. En ese
momento se detiene automaticamente la rotacién de archivos.
El contador inicia con AFRM.

Observe que inmediatamente después de activar AFRM se abre
un archivo de registro. Este archivo de inicio no se considera un
evento de rotacion de archivos, por lo que el contador AFRM no
disminuira.

Los valores van de 0 a [23-1]. El valor por defecto es 0 (cero).
Cero significa que se creara un namero ilimitado de archivos de
registro.

La memoria del receptor puede almacenar hasta
1024 archivos.

* Files (remain). Especifica el nimero de archivos que quedan en
el receptor pendientes de crear en AFRM. Los valores van de 0

a [231-1]. El valor por defecto es cero.

» Automatically remove old files. Elimina automaticamente el
primer archivo de registro existente cuando no queda espacio
disponible en la memoria para almacenar datos. Cuando este
parametro esté habilitado, su receptor borrara el archivo que
tenga la fecha/hora de creacién més antiguas. Para poder utilizar
esta funcion FIFO (First-in, First-Out — El primero que entra es
el primero que sale-) deberd esta activada en AFRM. El valor
por defecto es Off (desactivada).

FN Key Mode. Utilice estos dos botones de opcidn para programar el
modo en que reaccionara el receptor al pulsar la tecla FN.

» LED blink mode switch. Al pulsar la tecla FN cambiara entre
los modos de informacion normal y ampliado de la MINTER o
las funciones de inicio y parada del registro de datos en
levantamiento estatico.

- sise pulsa FN durante menos de 1 segundo: cambia el modo
de informacién (modo de informacion Normal o Ampliado).

- sise pulsa FN entre 1y 5 segundos: se inicia o se detiene el
registro de datos (modo de postproceso estatico).
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» Occupation mode switch. Al pulsar FN (menos de un segundo)
se introducira en el archivo de registro correspondiente un
mensaje que indica que el tipo de levantamiento ha cambiado de
estatico a cinematico o viceversa. Si el LED REC parpadea en
color verde, significa que el modo actual es dindmico, si el LED
parpadea en color naranja, significa que el modo actual es
estatico. Para ampliar informacion consulte la Tabla1 - 1 en la
pagina 12 y el Manual de referencia de PC-CDU.

Initial Data Collection Dynamic Mode Estos botones de opcion
especifican la descripcion del tipo de ocupacion que se ha introducido
al inicio de los archivos de registro del receptor. Seleccione Static o
Kinematic para especificar que el archivo de registro correspondiente
iniciard con ocupacion estatica (STOP) o cinemaética (GO, Trajectory)
respectivamente.

Data Recording Auto-start Estos botones de opcidn le permiten

programar el comportamiento de su receptor en caso de fallo de
alimentacion.

En la Tabla 3-3 se describen las diferentes situaciones posibles y los
resultados cuando se restablece la alimentacidn al receptor. Por
“Archivo especificado” se entiende el nombre de archivo introducido
en el campo Always append to file.

Tabla 3 - 3: Comportamiento del parametro Data Recording

Antes del fallo de Resultados del botén de opcidn seleccionado

alimentacion off on Always
. El receptor El receptor
El registro de datos . .
Datos del receptor no's egr canudara reanudara el reanudara el
registrados en el cuando se registro de datos registro de datos
archivo restablezca la cuando se cuando se
especificado. alimentacion restablezca la restablezca la
' alimentacion. alimentacion.
Cuando se Cuando se
. restablezca la restablezca la
El registr : ! : -
Datos del receptor egistro de d,atos alimentacion se alimentacion se
- no se reanudara A -
registrados en el cuando se abrira un nuevo abrira un nuevo
archivo restablezca la archivo de registro |archivo de registro
predeterminado. . - y los datos se y los datos se
alimentacion. . . . ;
registraran en este |registraran en este
archivo. archivo.
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Tabla 3 - 3: Comportamiento del parametro Data Recording (Continuacion)

Antes del fallo de
alimentacion

Resultados del botén de opcidn seleccionado

Off

On

Always

Archivo
especificado; no ha
iniciado el registro
de datos en el

No se abrird ningln
archivo con este
nombre. El registro
de datos no
comenzara cuando

No se abrira ningin
archivo con este
nombre. El registro
de datos no
comenzara cuando

Cuando se
restablezca la
alimentacion se
abrira un archivo de
registro con este

No hay ningin
archivo
especificado; el
registro de datos en
el receptor esta
desactivado.

El registro de datos
no comenzara
cuando se
restablezca la
alimentacion.

El registro de datos
no comenzara
cuando se
restablezca la
alimentacion.

nombre y se
receptor. se restablezca la se restablezca la - y
; - . i registraran los
alimentacion. alimentacion.
datos.
Cuando se

restablezca la
alimentacion se
abrird un archivo de
registro con un
nombre
predeterminado y
se registraran los
datos.

Asimismo, si esté habilitado el parametro Always, el receptor
comenzard automaticamente a registrar datos (en un archivo existente
0 de nueva creacion) en los tres casos siguientes:

» Después de encender el receptor pulsando el botdn de

encendido.

» Después de reiniciar el receptor (mediante PC-CDU).
» Después de salir del Modo de Espera.
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[l Receiver Configuration x|
General MINTER | Posiioning | Base | Rover | Parts | Events | Advanced |
Fiacarding iterva 100 [seconcs) F key mode
Eevatinmesk rLogfle: [ (emees) |Vr-‘ LED biink made switch Decupation mode switch
Fle name prefs B Iniil dat5 colection dymamic: mod
Always append tothe fie l— [G Sitatic ) Kinerastic

Files Creaticn mod Dt recording aute-star
lrt? Loa file £ AFRM (r-‘ O C n © Always
-

—Automatic Fls Retation Mods [AFRM] paramater

Prind fser)) [3600 Files (tatal]: [0

I | Avtornatically ey old files

Retesh | dopy |

Bt | Save | Set alpaameter to defaule
\

Figura 3-11. Pestaina MINTER

Construccion de un sistema de
cableado de antena

Un sistema de cables que se extiende entre las antenas y el receptor
debe cumplir determinados requisitos a fin de proporcionar el minimo
nivel de pérdida de sefial, ofreciendo asi una sefial de calidad.

 La longitud del cable se debe mantener a un minimo. Topcon
ofrece cables de distintas longitudes, desde 3 hasta 100 metros.

» Usar Unicamente cables coaxiales con poca pérdida. Para
distancias de hasta 10 metros, se recomienda usar el cable RG-
58 de Topcon. Si se requiere una longitud mayor (hasta 30
metros), se recomienda utilizar el cable RG-8 o LMR-400 de
Topcon. Para LMR-400 a 1600 MHz, la atenuacion es 0.2-0.1
dB/metro.

 Superior a 30 metros, considere usar unos amplificadores en
linea o unos cables adicionales con poca pérdida. Topcon ofrece
opciones de cable de 30 y 60 metros usando un LMR-400 y un
cable de 100 metros con LMR-600. Para el LMR-600 a 1600
MHz, la atenuacion es de 0.1 dB/metro.

 La atenuacion total del sistema de cables no debe ser superior a
10-12dB a 1,6 GHz.
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Para la instalacion de varios receptores y una sola antena, use
divisores de antena GNSS. Normalmente, los divisores tienen una
salida de RF que pasan CC del receptor NET-G3 conectado a través
del divisor a la antena. Las demas salidas de RF deben bloquear la
corriente CC para evitar dafos a la antena. El divisor también debe
tener un minimo aislamiento de RF de 20 dB RF entre sus salidas para
eliminar posibles interferencias entre los receptores conectados con
este divisor.

Para aplicaciones donde la alimentacion se suministra desde una
fuente separada, considere el uso de la polarizaciéon en T.

Habitualmente la polarizacion en T tiene dos conectores coaxiales y un
conector para alimentar el LNA de la antena desde una fuente de
alimentacion externa. Uno de los conectores coaxiales estard marcado
como RF + CC y en la clavija central aparecera CC. El otro conector
estara marcado como RF y bloqueado para CC. El conector restante
marcado como CC es donde debe aplicarse la alimentacion.

Instalacion del receptor como
estacion de referencia
temporal

La instalacion tipica de una estacion de referencia permanente o
semipermanente coloca el NET-G3 en una ubicacion segura con
acceso a los enlaces de alimentacién y comunicaciones segun se
requiera, y con una ubicacion de la antena libre de obstrucciones e
interferencias de sefiales (RF, multicamino, etc. que se haya medido
con mucha precision.

Como estacion de referencia temporal, deben ejecutarse determinados
pasos para garantizar una obtencion de datos adecuada. Las secciones
siguientes detallan el uso del NET-G3 en una configuracion de
estacion de referencia temporal.

Antes de registrar datos, verifique que el receptor contiene un
almanaque y datos de efemérides actualizados (véase “Obtencion de
almanaques y efemérides” en la pagina 2-11).
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Paso 1. Preparacion del receptor

1. Coloque el receptor en la ubicacién predeterminada. Un estante
solido 0 una mesa apartada puede ser un lugar adecuado.

Consulte “Dimensiones del NET-G3” en la
E _a pagina A-2 sobre los datos de medicién relativos a

-

la colocacién de los agujeros de tornillos para un
montaje permanente.

2. Para un montaje permanente, inserte cuatro tornillos a través de la
ubicacion (estante) de montaje y dentro de los agujeros de montaje
del receptor.

3. Enchufe el cable de alimentacion a una toma de corriente con
conexion a tierra. Para ampliar informacion y conocer las
precauciones, consulte “Alimentacion del receptor” en la
pagina 2-9.

4. Conecte el cable de la antena. Si se estan registrando los datos en
un dispositivo externo, conecte también el cable de comunicacion
necesario.
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A una toma
puesta a tierra

Al puerto de
alimentacion 1

Auna
antena
GPS

A un puerto de
antena GPS

Figura 3-12. Montar el receptor y conectar los cables

Paso 2. Medicion de la altura de la
antena

La situacion de la antena en relacion con el punto que se va a medir es
muy importante, tanto en levantamientos en los que se necesite
conocer la elevacion de los puntos como en levantamientos de
posiciones horizontales. A menudo, los levantamientos horizontales
cubren areas muy amplias que no se pueden adaptar de forma fiable a
una superficie plana, por lo que el ajuste de antena se hara en tres
dimensiones y a continuacion se proyectara en un plano
bidimensional.

El receptor calcula las coordenadas del centro de fase de la antena.
Para determinar las coordenadas del marcador del equipo, el usuario
debera especificar los siguientes parametros:

 Altura de la antena sobre el marcador de equipo.
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* Método de medicion de la altura de la antena.
* Tipo de antena utilizado.
En las antenas se pueden realizar dos tipos de mediciones:

» Vertical. Se mide desde el marcador al punto de referencia de
antena (ARP) situado en la parte inferior de la antena, en la base
de la rosca de montaje.

* Inclinada. Medida desde el marcador hasta el borde inferior de
la marca de medicion de altura inclinada de antena (SHMM).

El punto en el que se mide en el levantamiento con GNSS se denomina
Centro de Fase de la antena. Es analogo al punto en el que mide un
medidor de distancias en un prisma. El usuario debe introducir el
desplazamiento del prisma para compensar que el punto no esta en la
superficie fisica del prisma. En el caso de una antena GNSS, el
desplazamiento se introduce en funcién del tipo de medicion
adoptado.

» En la medicion vertical, el desplazamiento se afiade
simplemente a la altura vertical medida, obteniendo asi una
altura vertical “real”.

» En la medicidn inclinada se calculara en primer lugar la altura
vertical con el radio de la antena, y a continuacion se afiadira el
desplazamiento.

Los desplazamientos son diferentes debido a la diferencia de situacién
entre el punto de medicion inclinada y el punto de medicion vertical.

1. Mida la altura (inclinada o vertical) de la antena sobre el punto de
control o el marcador (Figura 3-13 en la pagina 3-21).

2. Apunte en sus notas de campo la altura de la antena, el nombre del
punto y el tiempo de inicio.

La altura de la antena y sus desplazamientos dependen del tipo de
antena utilizada. Para ampliar informacion, consulte la document-
acion de la antena.

Consulte la tarjeta de mediciones de
@ desplazamientos de la antena sobre los detalles de
medicion y desplazamiento.
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Superficie de referencia para las
mediciones de desplazamientos

Figura 3-13. Medicion de la altura de la antena - Ejemplo

Paso 3. Obtencion de datos

Para ampliar informacion sobre la obtencion de datos consulte las
secciones restantes de este manual.

1. Encienda el receptor. Inicialmente parpadeara el indicador
luminoso (LED) STAT (estado) en color rojo.

» Cuando el receptor capte uno o mas satélites, el indicador
luminoso STAT parpadeara en color verde para indicar los
satélites GPS y en naranja para los satélites GLONASS. Un
destello rojo corto indica que el receptor no ha calculado la
posicion. Con cuatro 0 més satélites se conseguird un calculo de
posicion optimo.

» Cuando haya desaparecido el destello rojo corto, el receptor
habra calculado una posicion y podré iniciarse el levantamiento;
antes de comenzar la obtencion de datos espere hasta que se
muestren las luces verde y naranja. Asi se garantiza que el
receptor tiene la fecha y la hora correctas y que esta captando
suficientes satélites para que los datos sean de buena calidad.

El proceso de localizacion de satélites normalmente dura menos
de un minuto. En una zona nueva, cubierta por vegetacion
espesa, 0 después de reiniciar el receptor, el proceso podria
durar algunos minutos.

2. Mantenga pulsada la tecla FN (durante mas de un segundo y
menos de cinco) para comenzar la obtencion de datos.
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3. Cuando el indicador luminoso REC (registro) se ilumine en color
verde, suelte la tecla FN. Ello indica que se ha abierto un archivo 'y
ha comenzado la obtencion de datos. EI LED REC parpadeara
cada vez que se guarden datos en la memoria.

Utilice PC-CDU para configurar el registro de
datos. Consulte la Seccion “Configuracion de la

@ MINTER” en la pagina 3-8 o el Manual de
referencia de PC-CDU.

Detencion del registro de datos

Detenga el registro de datos cuando necesite mover el receptor,
descargar datos o realizar funciones de mantenimiento.

1. Mantenga pulsada la tecla FN hasta que se apague el LED REC.

2. Para apagar el receptor, mantenga pulsada la tecla de encendido
hasta que se apaguen todas las luces.

Levantamiento estatico para
estaciones de referencia

El levantamiento estatico es el método clasico, muy adecuado para
todo tipo de levantamientos de estacion base. Un receptor sobre un
marcador topogréafico recoge datos brutos durante un periodo de
tiempo determinado. La duracion de las sesiones de observacion puede
variar de pocos minutos a algunas horas. La duracién dptima de la
sesion dependera de la experiencia del topdgrafo y de los siguientes
factores:

* el nimero de satélites a la vista.
* la geometria del satélite (DOP).

* lasituacién de la antena.

* el nivel de actividad ionosférica.
* los tipos de receptores utilizados.
* la precision requerida.
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* la necesidad de resolver ambigiiedades de fase de portadora.
Generalmente, para lineas base de hasta 15 kilometros (9,32
millas) se utilizan receptores monofrecuencia. Con lineas base
de 15 kilémetros o superiores se utilizan receptores
bifrecuencia.

Los receptores bifrecuencia ofrecen dos ventajas fundamentales. En
primer lugar, los receptores bifrecuencia pueden detectar y eliminar
todos los efectos ionosféricos de las mediciones de fase de c6digo y de
fase de portadora, proporcionando asi una precision muy superior a la
de los receptores monofrecuencia cuando las lineas base son muy
largas o en presencia de tormentas ionosféricas. En segundo lugar, los
receptores bifrecuencia requieren tiempos de observacion mucho mas
cortos para alcanzar la precision deseada.

Una vez completado el levantamiento, los datos recogidos por los
receptores se pueden descargar a un ordenador y procesar con un
software de postproceso (por ejemplo, Topcon Tools).

Funcionamiento de la MINTER

La MINTER es la interfaz minima del receptor que se emplea para
presentar y controlar la entrada y salida de datos (Figura 3-14).

LED de
LED STAT  LED LINK alimentacion  Boton de funcion

Botén de
encendido

LED REC LED RX/TX

Figura 3-14. MINTER de NET-G3
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La MINTER permite ejecutar numerosas funciones, entre las que se
incluyen las siguientes:

» Encender y apagar el receptor.
* Activar o desactivar el registro de datos (tecla FN).
 Cambiar el modo de informacién del receptor.

» Mostrar el nimero de satélites GPS (verde) y GLONASS
(naranja) que se estan recibiendo (LED STAT).

» Mostrar el estado de registro de los datos y cada vez que estos
se registran en la memoria interna (LED REC).

» Mostrar el estado del modo de postproceso (estatico o
dindmico) durante un levantamiento cinematico con
postproceso (LED REC).

* Mostrar el estado de la alimentacion del receptor (LED PWR).

En la Seccion “MINTER” en la pagina 1-9 encontrara una descripcion
completa de la MINTER.
Para encender o apagar el receptor, pulse el botén de encendido
(Figura 3-15).
« Para encenderlo, pulse el botén de encendido hasta que
destellen brevemente los LED de la MINTER.

 Para apagarlo, pulse el botdn de encendido hasta que se
apaguen el LED PWR se ponga rojo; a continuacion suelte el
boton.

Para encender y apagar el receptor Boton de encendido
pulse el botén de encendido durante
1 segundo aproximadamente.

Figura 3-15. Funciones del botéon de encendido
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Para comenzar/detener el registro de datos, pulse el botén FN de
1 a 5 segundos (Figura 3-16).

» Durante el registro de datos, el LED REC esta de color verde.
Use PC-CDU para establecer el intervalo de tiempo de registro.
Para ampliar informacion consulte el apartado “Recording
Interval” en la pagina 3-11.

» Cada vez que se registren datos en la memoria del receptor, el
LED REC parpadeara en color verde.

» Siel LED REC esté de color rojo, el receptor ha agotado la
memoria, o tiene un problema de hardware, o contiene un OAF
incorrecto (para ampliar informacion consulte “Archivo de
autorizacién de opciones (OAF)” en la pagina 1-20).

Use PC-CDU para activar en el receptor el modo de la tecla FN que
desee: “LED blink mode switch”, para levantamientos estaticos o
“Occupation mode switch” para levantamientos cinematicos. Para
ampliar informacién consulte el apartado “FN Key Mode.” en la
pagina 3-13.

Cada vez que active o desactive el registro de datos se abrird un nuevo
archivo o se afiadiran los datos a un archivo determinado. En “Always
Append to the File” en la pagina 3-12 y en “Files Creation Mode” en
la pagina 3-12 se describe la forma de configurar estas funciones.

Para iniciar/detener el registro de datos Botén de funcién
pulse el botén FN de 1 a 5 segundos. /

Figura 3-16. Funciones del boton FN
Para alternar entre los modos de posproceso, pulse el botén FN
durante menos de 1 segundo una vez activado el modo “Occupation
mode switch” mediante PC-CDU.
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Para cambiar el modo de informacién del receptor, pulse el boton
FN durante menos de 1 segundo una vez activado el modo “LED blink
mode switch” mediante PC-CDU.

Para cambiar la velocidad de comunicacion del puerto serie del
receptor, pulse el boton FN de 5 a 8 segundos. Esto es til cuando el
colector de datos no admite la velocidad que se ha ajustado para el
puerto serie.

Al cabo de unos cinco segundos, el LED REC se pondréa de color rojo.
Suelte el botén FN durante los tres segundos siguientes.

Analisis de la relacion senal-ruido

Conocer la fuerzay fiabilidad de la sefial de determinacion transmitida
desde los satélites le ayudara a determinar la calidad de las sefiales de
los satélites. Use la Tabla 3-4 para ayudarle a estimar la calidad de la
sefial desde un vehiculo satélite.

Tabla 3 - 4: Valores SNR tipicos

E'e"?;ir‘;zg:)' Sva Ca(r;a;:;l-lez)CIA Canal P1 (dB*Hz) | Canal P2 (dB*Hz)
10-20 >35 >10 >10
20-40 >40 >20 >20
40-60 >45 >30 >30
60-90 >50 >40 >40

a. SV =vehiculo satélite

Si el valor SNR de una sefial de satélite es inferior al valor umbral de
la tabla, preste mucha atencién a ese satélite ya que puede ser una
fuente de problemas a la hora de obtener unos resultados de tiempo
estimado y posicionamiento precisos.

Trabajo con dispositivos externos

El receptor NET-G3 se puede conectar a varios dispositivos externos
para efectuar calibraciones de frecuencias y sincronizacion de
tiempos, marcado de tiempo de eventos externos, mediciones
meteoroldgicas y distribucién de correcciones diferenciales.
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Si tiene problemas o preguntas sobre el uso del NET-G3 con estos
dispositivos, pongase en contacto con su distribuidor Topcon local.
Para la informacién de contacto, visite el sitio Web TPS en:

http://www.topconpositioning.com/static/dealer_pointer.php
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Notas:
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Capitulo 4

Mantenimiento del
receptory los
archivos

Si se desea ejecutar un postproceso al termino de un levantamiento, los
datos de la memoria del receptor tendran que descargarse en un
ordenador. Ademas, al descargar y borrar los archivos se prepararé la
memoria del receptor para el siguiente levantamiento. En ocasiones, la
memoria NVRAM del receptor podria tener que borrarse para eliminar
problemas de comunicacion o de seguimiento.

A medida que las expectativas del proyecto aumentan, podria ser
necesario actualizar el archivo OAF del receptor para ampliar sus
funciones. La tarjeta GPS que esta dentro del receptor requiere un
firmware para funcionar correctamente y proporcionar las funciones
adecuadas. Cuando TPS ponga en circulacién nuevas actualizaciones
de firmware, carguelas en el receptor para garantizar que opera con su
potencial méaximo.

Descarga de archivos desde
una tarjeta de memoria
instalada

Al término de un levantamiento, descargue los archivos de datos de la
tarjeta de memoria instalada en el receptor a un ordenador para
guardarlos, postprocesarlos o hacer copias de seguridad. Ademas, la
tarjeta de memoria del receptor tiene una capacidad limitada de
almacenamiento de archivos e informacion, por lo que al descargar los
datos se evita la pérdida de archivos. Los pasos siguientes utilizan PC-



Mantenimiento del receptor y los archivos

CDU para descargar archivos, pero se puede utilizar cualquier
software de gestion del receptor Topcon.

1. Conecte su receptor a un ordenador. Este procedimiento se explica
en la seccion “Conexion del receptor a un ordenador” en la
pagina 2-12.

2. En el cuadro de didlogo Connection Parameters, habilite el
protocolo de enlace RTS/CTS handshaking y haga clic en Connect
(Figura 4-1).

[ Connection Parameters x|
Connecion mode
& Direct " Intesnet Clisnt " Iniernet Server |

Part setfing
Pt [COM1 =] Baudrate: [115200 =] I Infrered port
¥ RTS/CTS handshaking

I

Prograr setting
[~ Pasivemade [~ ‘ama\ mode caly  Timeout [ms]: | 500 b2

vighal baud rate on Disconned:

¥ RTS/CTS handshaking [
TCP pot W

Pesswoid: |

[T Disglay data o server [ Log server events ™ ONS lookuz
Cancel
Figura 4-1. Parametros de conexion. RTS/CTS Handshaking

3. Haga clic en File » File Manager y a continuacion en la pestafia
Download path del cuadro de diadlogo File Manager (Figura 4-2).

51
Download files I Current log file | Dowrlo% path |

Total memory: 47348784 bytes Free memany: 47164824 bytes
Name | Size | Date I Time
log03235 75196 23.09.2002 8:49:52
log0323b 76795 23.09.2002 851:53
log0324a 5661  24.03.2002 452:51
log0324b 4701 24.03.2002 9:52:59
log0924c 4333 24.09.2002 9:53:44
log0924d 5190 24.09.2002 9:53:55
log0924e 4676 24.09.2002 9:54:06
log0324f 4162 24.09.2002 95416

Save to: EATESTINGADATA
I~ Exclusive mode
Using: |Eu;- part ['J‘.':\j Blnckswze:|512 bytes :I
Download |  Delete | Refresh | Ext |

Figura 4-2. Localizacion de archivos para descarga

4. Busque o cree (mediante el botdn Create) la carpeta en la que
desea descargar y guardar los archivos.
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5. Haga clic en la pestafia Download files y seleccione los archivos

gue desea descargar (Figura 4-3).
Para seleccionar varios archivos a la vez, mal

ntenga pulsada la

tecla SHIFT y haga clic en archivos que no vayan seguidos o
mantenga pulsada la tecla CTRL y seleccione diversos archivos

individuales.

Download files | Current log file | Download path]
Total memory: 47348784 bytes

Free memary: 47164824 bytes

x|

Ddel

Size |

24.09.2002
24.03.2002

lng0324b
Ing0324c

4701
4933

352:59
35344

4 2
4162 24.09.2002 k 35416

IogD324f

Save tor EATESTINGA\DATA

‘ [~ Exclusive mode

Time [

COM2Z] ;I Block size: |512hyles
Delete | Retesh | Ext |

Using: | Curent por

Download |

=

|

Figura 4-3. Descarga de archivos

Haga clic en el boton Download. Durante la

descarga Se muestra

un indicador de estado junto a cada uno de los archivos (Figura 4-

4 en la pagina 4-4).

* Indicador azul: archivo en cola de descarga.

* Indicador rojo. Archivo en curso de descarga.

* Indicador verde. El archivo se ha descargado con éxito.
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x
Daowinload files | Current log H\EI Download palh]
Total memony: 47348784 bytes Free memory: 47164824 bytes
I Name I S\zal Date [ T\me'
® 10g0323a 75196 23.08.2002 84352
® 10903230 76795 23.08.2002 851:53
® |0g0324a 5661  24.08.2002 952:51
® |ogl324b 4701 24.09.2002 952:59
log324c 4933 24.09.2002 95344
log924d 5190 24.09.2002 95355
log0924e 4676 24.09.2002 354:06
log0324f 4162 24.09.2002 35416
Save to: EATESTING\DATA
| Blocks: 28 I~ Exclusive mode
Using: [Cunent port COM2) =] Block size: [512bytes =]
Stop | Delete | Hefrest | Exit |
19% | Downloading log0923a...

Figura 4-4. Descarga de archivos. Indicadores de estado
7. En el cuadro de didlogo File Manager haga clic en Exit.

8. Continle con la siguiente operacion. O, haga clic en File »
Disconnect, y a continuacion en File » Exit para salir de PC-
CDU.

Descarga de archivos de datos
de una tarjeta de memoria
extraida

Después de extraer la tarjeta de memoria del receptor, se pueden
descargar los datos utilizando Topcon Link. Se requiere un lector de
tarjetas CF en o conectado al ordenado para acceder a los datos de la
tarjeta. Antes de que Topcon Link pueda leer datos de la tarjeta de
memoria, la tarjeta debe formatearse para dispositivos Topcon.

 Elicono del dispositivo para una tarjeta formateada sera rojo.
 Elicono del dispositivo para una tarjeta no formateada sera gris.

Consulte el Manual del usuario de Topcon para

@ obtener una descripcién completa de como
trabajador con datos de una tarjeta de memoria.

1. Inserte la accesorio en el lector de tarjetas.
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Borrado de archivos de datos de una tarjeta de memoria instalada

2. Vaya al directorio del dispositivo para tarjetas de memoria Topcon
y haga clic en el icono del dispositivo.

3. Haga clic en el icono del dispositivo de tarjetas de memorias
formateadas que desee.

4. Despues de colocar la tarjeta, seleccione y copie, o seleccione y
arrastre y coloque los archivos que desee en un directorio del
ordenador.

File Edt View Favorites Tools Help

OBack \ ) ? F. Search | |{— Folders

Address B He
Folders x

= ™ Topcon Memory Cards PC-CDU PC-COU
lng0S05a.tps logD505h.tps

Figura 4-5. Importar de la tarjeta de memoria

Borrado de archivos de datos
de una tarjeta de memoria
instalada

Una tarjeta de memoria contiene una cantidad limitada de datos
recogidos. Para liberar espacio para afiadir mas datos o datos nuevos,
borre los datos antiguos. Para ampliar informacién acerca de la gestion
de la memoria del receptor, consulte “Administracion de opciones del
receptor” en la pagina 4-8. Los pasos siguientes utilizan PC-CDU para
descargar archivos, pero se puede utilizar cualquier software de
gestion del receptor Topcon.

También puede configurar el receptor para que borre los archivos

automaticamente usando la funcion first-in-first-out (consulte

“Automatic File Rotation Mode (AFRM)” en la pagina 3-12 para

ampliar informacion).

1. Conecte su receptor a un ordenador. Este procedimiento se explica
en la seccion “Conexion del receptor a un ordenador” en la
pagina 2-12.
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Mantenimiento del receptor y los archivos

2. Enel cuadro de didlogo Connection Parameters, marque la casilla
RTS/CTS handshaking (Figura 4-6 en la pagina 4-6).

[ Connection Parameters B

Cerneclion mode:
& Direct " Intemet Client " Iniemnet Server |

Por seting
Pot [0OM1 =] Baudrate: 115200 | ™ Inirared port
[V RTS/CTS handshaking

Frogam seing: I
[ Passivenode [~  _— clp Timeout st 00~
rigial baud rake on Discornect

W RTS/CTS handshaking s
T patt [ |

Pessiod: |

I=| Disslaydata crsercer 2| Lo serverevents I DS ookio

Cancel
Figura 4-6. Parametros de conexion. RTS/CTS Handshaking

3. Haga clic en File » File Manager y seleccione los archivos que
desea borrar en la pestafia Download files (Figura 4-7 en la
pagina 4-7).
Para seleccionar varios archivos a la vez, mantenga pulsada la
tecla SHIFT y haga clic en archivos que no vayan seguidos, 0
mantenga pulsada la tecla CTRL y seleccione varios archivos
individuales.

4. Haga clic en Delete (Figura 4-7 en la pagina 4-7).

5. En el cuadro de didlogo de confirmacion de borrado de archivos,
haga clic en Yes. PC-CDU borraré los archivos seleccionados.

6. En la pantalla File Manager, haga clic en Exit.

7. Continle con la siguiente operacion. O haga clic en File »
Disconnect, y a continuacion en File » Exit para salir de PC-
CDU.
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Administracion de la memoria del receptor

x

Download files | Current log file | Download palhl
Total memory: 473468764 bytes Free memory: 47164824 bptes

Size | Dats | Time

24.09.2002
24082002

e S 5505
\nﬁDSZd[ 24.09.2002

Save to: EATESTINGADATA

| I Exclusive mode
Using: |, urent port ([COM2| LJ Block size: |512hytes LJ
Quwn\uadl Delegelkl Refiesh | Exit I

[ \

Figura 4-7. Borrado de archivos

Administracion de la memoria
del receptor

Al utilizar el receptor en aplicaciones estaticas o dindmicas podria
necesitar saber la cantidad de memoria que ocupa el archivo de
registro del receptor. EI tamafio de la memoria dependeré del tipo de
datos que se registren. Las siguientes formulas le permitiran calcular
el tamafio aproximado de los archivos de registro del receptor. Estas
ecuaciones estan basadas en el conjunto de mensajes por defecto.

» SS. Tamafio estimado de una época de datos brutos en el
archivo de registro del receptor (expresado en bytes).

» N. NUmero de satélites observados por época.
Cuando se registren Unicamente datos L1:

SS =183 + 22*N
Cuando se registren datos L1y L2:

SS =230 + 44*N

La Tabla 4-1 muestra la cantidad de memoria de archivos que requiere
el receptor para las mediciones de datos brutos obtenidos durante una
hora. La cantidad de memoria depende del nimero total de satélites
GNSS observados y utilizados en el calculo de la posicion y el
intervalo de registro.
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Mantenimiento del receptor y los archivos

Tabla 4 - 1: Cantidad de memoria requerida para almacenar archivos
durante una hora

Intervalo de registro (segundos)
N° de VS
0.1 1 5 15 30
Receptor de sistema dual monofrecuencia
Memoria necesaria para registrar datos
6 11 MB 1.1 MB 221 KB 74 KB 37 KB
10 14 MB 1,4 MB 283 KB 94 KB 47 KB
14 17 MB 1,7 MB 345 KB 115 KB 57,5 KB
18 20 MB 2 MB 407 KB 136 KB 68 KB
Receptor de sistema dual de doble frecuencia
Memoria necesaria para registrar datos
6 17 MB 1,7 MB 347 KB 116 KB 58 KB
10 23 MB 2,3MB 471 KB 157 KB 78,5 KB
14 29 MB 2,9 MB 595 KB 198 KB 99 KB
18 35 MB 3,5MB 720 KB 240 KB 120 KB

Administracion de opciones
del receptor

El Archivo de Autorizacion de Opciones habilita determinadas
funciones, caracteristicas y opciones en el receptor, como las
siguientes:

* el tipo de sefial (L1 o L1/L2) que procesara el receptor;
* lacantidad de datos que guardaré el receptor en la memoria;
 lavelocidad a la que se transmitiran o recibiran los datos.

Si desea obtener una lista completa de las opciones disponibles y los
detalles correspondientes, consulte con su distribuidor TPS.
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Administracion de opciones del receptor

Comprobacion del OAF del receptor

Los OAF del receptor enumeran todas las funciones activadas o
desactivadas. Para determinar si una funcion esté activada o cuéles
son las funciones disponibles, compruebe que los OAF del receptor
estan utilizando el software de gestion del receptor Topcon disponible.
Los pasos siguientes utilizan PC-CDU para ver las opciones.

1. Conecte su receptor a un ordenador. Este procedimiento se explica
en la seccion “Conexion del receptor a un ordenador” en la
pagina 2-12.

2. Haga clic en Tools » Receiver Options. El cuadro de dialogo

Options Manager (Figura 4-8 en la pagina 4-10) presenta los
siguientes datos:

» Option name. EI nombre o descripcion de la opcion.
Current. Estado actual de la opcion.
 Purchased. Si la opcion ha sido comprada o no.

Leased. Si la opcion ha sido contratada o no.

Expiration date. Fecha en que la opcion quedara desactivada, si
es de aplicacion.

Como las opciones se pueden comprar o contratar, el estado “Current”
de la opcion muestra el valor actual efectivo. Dicho valor puede ser
uno de las siguientes:

e -104“-----": la version de firmware no incluye esta opcion.
 0: la opcion del receptor esta desactivada.

» numero entero positivo: la opcidn esta activada.

* si o no: laopcion esta activada o desactivada.

3. Al acabar, haga clic en Exit en el cuadro de didlogo Option
Manager y a continuacion haga clic en File » Disconnect para
desconectarse de PC-CDU (y evitar conflictos con la
administracion del puerto serie).
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o]

Option name | Curert | Puichased| Leased | Ewp.date |4
[Teok GPS yes yes no
Initialize file system E.:* ONASS i:: ﬁ:: zg
Clear NVRAM L2 yes yes no
Reset receiver Cinderella yes yes no
_— Position update rate [Hz) 20 20 0
Raw data update rate [Hz) 20 20 1]
Code differential Base ves yes no
Code differential Rover ves yes no
RATK Base ves yes no
RTK Raver [Hz) 20 20 1]
Memory (Mb) 76 76 0
Co-Op Tracking yes yes no
1-PPS Timing Signal 2 2 0
Event Markers 2 2 0
In-Band Int. Rejection 1 1 1]
Multipath Reduction yes yes no
Frequency Input yes yes no
Freq. Lock and Dutput yes ves no
Serial Port & [Kbps) 460 460 1]
Senal Port B [Kbps] 460 460 0
Senal Port C (Kbps) 460 480 0
Serial Port D [Kbps) 460 450 i
Infrared Part ho no no
Parallel Port no no
Sp.Sp. Freq Hop. no ha no
Sp.Sp. Direct no ha no
RalM yes yes no
Datums support yes yes no
Magnetic azimuth yes yes no

Geoid height ves yes no —
Way Point Navigation yes no

WAAS ves es yes 8/1/2001

OMMISTAR yes no
ATCM Output 3 2 1]
RTCM Input 2 2 1]
CMR Output 1 1 1]
CMA Input 1 2 1]
JPS Output 1 0 1]

JPS Input 2 i} 0 ;'

Refresh l Load I Stop I Exit I
| 4

Figura 4-8. Vista del administrador de opciones

Carga de un OAF

Los distribuidores de Topcon Positioning System proporcionan
archivos OAF a sus clientes. Si adquiere un OAF actualizado para el
receptor, tendra que cargarlo antes de poder utilizar la nueva funcion.
Los pasos siguientes utilizan PC-CDU para cargar el archivo de
opciones.

Para las consultas relacionadas con los OAF, envie un correo
electronico a TPS a options@topcon.com e incluya el nimero de 1D
del receptor.
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Puesta a cero del receptor

. Conecte su receptor a un ordenador. Este procedimiento se explica
en la seccion “Conexion del receptor a un ordenador” en la
pagina 2-12.

. Haga clic en Tools » Receiver Options.

. En la parte inferior del cuadro de dialogo Option Manager, haga
clic en Load (véase Figura 4-8 en la pagina 4-10).

. Busque el nuevo archivo de autorizacion de opciones. Los OAF
tienen extensiones .jpo o .tpo y son exclusivos para cada receptor
(Figura 4-9).

21|
Laok in: Im Desktap j « & ¥ BB~

fﬂMy Documents
=] My Computer
15K My Network Places

File name: Open D
Files of type: |JF‘5 Options files ;j Cancel

Figura 4-9. Carga de OAF

. Seleccione el archivo apropiado y haga clic en Open (Figura 4-9).
La nueva opcion se cargaré en el receptor y se actualizara la tabla
del administrador de opciones.

. Al finalizar haga clic en EXxit, en el cuadro de didlogo Option
Manager y a continuacion haga clic en File » Disconnect para
evitar conflictos en la administracion del puerto serie.

Puesta a cero del receptor

En caso de que los botones o el software del receptor dejen de
responder, ejecute un reinicio del hardware. El reinicio del hardware
solo debe ejecutarse cuando el receptor esta encendido y no responde
de ninguna otra forma.
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Mantenimiento del receptor y los archivos

El reinicio del hardware simplemente efectla un
@ ciclo de alimentacion, no borra la informacion
almacenada en la memoria del receptor.

1. Quite la puerta delantera.

2. Inserte un clip de papel o cualquier punta lo bastante pequefia para
que entre en el agujero de la clavija (Figura 4-10).

3. Presione suavemente el boton de reinicio durante un segundo
aproximadamente hasta que la unidad se apague.

Boton de reinicio de
hardware metido

Figura 4-10. Reinicie el receptor

Borrado de la memoria NVRAM

La Memoria de Acceso Aleatorio No Volatil (NVRAM) almacena los
datos requeridos para el seguimiento de los satélites, como los datos de
efemérides y la posicion del receptor. La NVRAM contiene también
la configuracidn actual del receptor, como la entrada de antena activa,
las méscaras de elevacion, el intervalo de registro y la informacion del
sistema de archivos interno del receptor.
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Borrado de la memoria NVRAM

Si bien el borrado de la memoria NVRAM no es una operacién
habitual (ni tampoco recomendable, generalmente), en determinadas
ocasiones puede solucionar problemas de comunicacién o de
seguimiento. Borrar la NVRAM de su receptor equivaldria a un
“reinicio parcial” de su ordenador.

Después de borrar la NVRAM, su receptor tardara algln tiempo en
obtener nuevos almanaques y efemérides (aproximadamente 15
minutos).

Al borrar la NVRAM de su receptor no se borraran los archivos
registrados en la memoria de su receptor. No obstante, la
configuracion de su receptor volvera a los valores predeterminados.

La NVRAM contiene también informacion sobre el sistema de
archivos del receptor. Tenga en cuenta que después de borrar la
NVRAM, el LED STAT del receptor parpadeara en color naranja
durante unos pocos segundos, indicando que el receptor esta
explorando y verificando el sistema de archivos.

Uso de la MINTER para borrar la
memoria NVRAM

1. Pulse la tecla de encendido para apagar el receptor.
2. Mantenga pulsada la tecla FN.

3. Mantenga pulsada la tecla de encendido durante un segundo
aproximadamente. Suelte la tecla de encendido sin soltar la tecla
FN.

4. Espere hasta que los LED STAT y REC estén de color verde.

5. Espere hasta que los LED STAT y REC parpadeen en color
naranja.

6. Cuando los LED STAT y REC parpadeen en color naranja suelte la
tecla FN.

Uso de PC-CDU para borrar la
memoria NVRAM

1. Conecte su receptor a un ordenador. Este procedimiento se explica
en la seccion “Conexion del receptor a un ordenador” en la
pagina 2-12.
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Mantenimiento del receptor y los archivos

2. Haga clic en Tools » Clear NVRAM (Figura 4-11).

Tools

Initialize file system

Resel receiver !

Receiver options

Figura 4-11. Borrado de la memoria
NVRAM con PC-CDU

Durante el borrado de la memoria NVRAM, el LED REC parpadeara
en color verde y rojo; el LED STAT parpadeara en color rojo. El
receptor se desconectard automaticamente al finalizar.

Cambio del modo del receptor

El receptor tiene los tres modos siguientes; dos modos de informacién
y un modo de alimentacion.

* Modo normal. Modo de levantamiento estandar.

» Modo de informacion ampliada. Se usa para efectuar pruebas
durante el funcionamiento normal.

» Modo de espera. Apaga el receptor pero lo mantiene encendido
en estado de inactividad y listo para activarse a través de
cualquier entrada en un puerto serie.

Introduccion al Modo de informacion
ampliada

El Modo de Informacién Ampliada (EIM) se utiliza para efectuar
pruebas del receptor. En este modo, el receptor continta funcionando
normalmente, pero el LED STAT indica informacion “ampliada”
mediante un delimitador.

El delimitador es un doble destello caracteristico que muestra el estado
general de las pruebas ejecutadas en la EIM. El color del LED del
delimitador se calcula a partir de los colores de los otros destellos de
LED, y ser& uno de los colores siguientes cuando haya finalizado la
prueba:

 Naranja: al menos uno de los destellos es naranja.
* Rojo: no hay ningun destello naranja y al menos hay uno rojo.
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Cambio del modo del receptor

» \erde: todos los demés casos.

Al doble destello del separador le siguen seis destellos de LED que
corresponden a seis pruebas del receptor, en las que cada destello
indica la siguiente informacion:

Destello 1.
Destello 2.

Destello 3.

Destello 4.

Destello 5.

Destello 6.

Datos suficientes para el calculo de posicion.

Las relaciones Sefial-Ruido GPS son correctas
(Tabla 4-2).

Las relaciones Sefial-Ruido GLONASS son
correctas (Tabla 4-2).

El desplazamiento de la frecuencia del oscilador es
inferior a 3 ppm (partes por millon).

La varianza de Allan del oscilador es mejor que
2,7e-10 (actualmente, siempre naranja).

El tiempo de seguimiento continuo es superior a 15
minutos.

Tabla 4 - 2: Relaciones Sefal-Ruido (S/N) “correctas”

CA/L1

P/L1

P/L2

GPS

51

39

39

GLONASS

51

49

40

El color del destello indica que la informacion de la prueba no esta
disponible (naranja), que el receptor ha superado la prueba (verde) o
que el receptor no ha superado la prueba (rojo).

1. Para cambiar a EIM, pulse y suelte rapidamente (menos de 1
segundo) la tecla FN de la interfaz MINTER.

2. Observe el doble destello del delimitador. Con un buen receptor,
una buena antena y buenas condiciones de observacion, todos los
destellos deberan ser verdes antes de transcurridos 15 minutos
desde el encendido.

* \erde: OK.

» Naranja: espere.
» Rojo: algunas pruebas no han sido superadas.
3. Para volver al modo normal pulse la tecla FN.
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Mantenimiento del receptor y los archivos

Modo de espera (desactivacion)
El modo de espera es el modo de desconexion normal del receptor.
1. Encienda el receptor.

2. Mantenga pulsada la tecla de encendido del receptor de cuatro a
ocho segundos. EI LED STAT se iluminara en color naranja. El
receptor se pondra en modo de espera.

3. Cualquier actividad en el puerto de comunicacion serie hara que se
active el receptor.

Si mantiene pulsada la tecla de encendido durante
% mas de 14 segundos, el dispositivo ignorara la
@ accion. Esto es un sistema de proteccion del
receptor contra la posibilidad de que una tecla se
guede encajada.

Carga de nuevo firmware

Utilice la Gltima version disponible en el sitio web de TPS para
asegurarse de que instala en su receptor la actualizacién mas reciente.

El receptor NT-G3 debera cargarse con la version
de firmware 3.1 0 una posterior.

/\ No intente cargar versiones de firmware anteriores
PRECAUCION ala3.1.

El firmware de la tarjeta del receptor esta disponible en un archivo
comprimido que debera descargar y descomprimir. Este archivo
contiene los dos siguientes archivos:

» ramimage.ldr. Archivo RAM de la tarjeta del receptor.
» main.ldp: Archivo Flash de la tarjeta del receptor.
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Carga de nuevo firmware

Cuando cargue un nuevo firmware debera cargar
@ todos los archivos. Estos archivos deberan proceder
del mismo paquete de firmware.

El receptor usa FLoader, una utilidad basada en Windows®, para
cargar el firmware. Puede descargar el programa FLoader a su
ordenador desde el sitio web de TPS. Para ampliar informacion
consulte el Manual del usuario de FLoader, disponible también en el
sitio web de TPS. Para instalar FLoader en su ordenador consulte la
Seccion “Instalacion de FLoader” en la pagina 2-7.

1. Si es necesario, descargue el nuevo paquete de firmware en su
ordenador.

2. Conecte su receptor a un ordenador. Este procedimiento se explica
en la seccion “Conexion del receptor a un ordenador” en la
pagina 2-12.

3. Ejecute FLoader.

4. En la pestafia Connection, seleccione el puerto COM de su
ordenador que esté conectado a su receptor y seleccione la
velocidad (normalmente 115200) (Figura 4-12).

File Options Help

Connection |Davit:e} nglaml

Connection Type:

Connection Settings

PC Port: CoM1 ¥| ‘WodLlength |8 e
Baud rate: 115200 | Paity: None s
Handshaking: | None il Stop Bits: 1 -

| [25ulz002 [16:06.11

Figura 4-12. Pantalla principal de FLoader

5. Haga clic en la pestafia Device y configure Device Type como
receptor. A continuacion haga clic en Get from Device para
Device Information (Figura 4-13 en la pagina 4-18).
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Mantenimiento del receptor y los archivos

B TPS Fiimware Loader: Device = Receiver
File Options Help

Connection Device I Plngraml

Device Type: Receiver 'I

Device Informatio

Model:

1D:

Firmvrare:
Hardware:
RAM Size, KB:

Save to file l LCancel I

| [31 Mar 2003 [17.53.44

Figura 4-13. Seleccion del tipo de dispositivo
6. Haga clic en la pestafia Program y seleccione el valor Soft Break
Capture (recomendado) en el campo Capture Method (Figura 4-
14).

TPS Firmware Loader: Device = Receiver
File Optons Help

Connection | Device Program ]

Capture Methad: | Soft Break Capture 2

3 RAM file: [C:\Floaderhggdt_2_S\amimage Idr | BrowseRl
 Flash file: [C: \Floader\hgodt_2_5\main Idp | BrowseF

Cancel

| |15 Mar 2005 [18:29.37

Figura 4-14. Ajustes de la pestaina Program
7. Busque y seleccione el archivo RAM y el archivo Flash de la
tarjeta del receptor (Figura 4-14).

8. Haga clic en Load y espere hasta que se hayan cargado
completamente todos los archivos en el receptor.

Si ha seleccionado un archivo incorrecto aparecera
@ un mensaje de error en la parte inferior del cuadro
de dialogo. Seleccione el archivo correcto.
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Carga de nuevo firmware

9. Haga clic en File » Exit.

10.Después de cargar el nuevo firmware, borre la memoria NVRAM
del receptor (véase “Borrado de la memoria NVRAM” en la
pagina 4-12) y actualice el almanaque (véase “Obtencion de
almanaques y efemérides” en la pagina 2-11).
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Notas:
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Capitulo 5

Resolucion de
problemas

Este capitulo le ayudard a diagnosticar y resolver algunos problemas
comunes que podria encontrar en su receptor.

No trate de reparar el equipo por su cuenta. Si lo
hace anulara la garantia y podria dafiar el hardware.

Comprobaciones previas

Antes de contactar con el servicio de asistencia de Topcon, ejecute las
siguientes verificaciones:
» Compruebe minuciosamente todas las conexiones de los
receptores externos para cerciorarse de que son correctas y
seguras.

» Vuelva a comprobar si hay cables desgastados o defectuosos.
» Compruebe todas las fuentes de alimentacion.

» Compruebe que el ordenador tiene instalada la ltima version
de software, y que el receptor tiene instalada la Gltima version
de firmware. Verifique las Gltimas actualizaciones en el sitio
web de TPS.

A continuacidn intente lo siguiente:
* Reinicie el receptor con PC-CDU (Tools » Reset receiver).

» Restablezca la configuracién predeterminada con PC-CDU
(Configuration Receiver, y a continuacién haga clic en Set all
parameters to defaults).



Resolucién de problemas

» Borre la NVRAM (consulte “Borrado de la memoria NVRAM”
en la pagina 4-12).

* Inicie el sistema de archivos (haga clic en Tools » Initialize file
system). De este modo se borraran todos los archivos del
interior del receptor.

Si el problema persiste consulte las siguientes secciones para encontrar
otras soluciones.

Lista rapida de resolucion de
problemas

Problemas de alimentacién del receptor:
Si el receptor no se enciende, consulte la pagina 5-2.
Problemas del receptor:

Si el receptor no puede establecer una conexién con un ordenador
0 un controlador externo consulte la pagina 5-3.

Si el receptor no capta los satélites durante un periodo prolongado
consulte la pagina 5-4.

Si el receptor capta un nimero de satélites insuficiente consulte la
pagina 5-4.

Si el receptor no puede obtener soluciones de codigo diferencial ni
RTK, consulte la pagina 5-5.

Si el receptor no inicia el registro de datos consulte la pagina 5-7.

Problemas de alimentacion

A continuacion se exponen algunos de los problemas de alimentacion
gue se producen con mayor frecuencia.

El receptor no se enciende.

= Una fuente de alimentacién externa podria estar conectada
incorrectamente.

e Compruebe que la fuente de alimentacion esta
correctamente conectada.
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Problemas del receptor

» Compruebe que los contactos de la fuente de alimentacion
estan limpios y sin polvo.
= La fuente de alimentacién podria estar descargada (si se utiliza
una bateria) o no proporcionar suficiente potencia.

Conecte/instale una bateria completamente cargada o una
fuente de alimentacion correcta y vuelva a intentarlo. Véase
“Alimentacion del receptor” en la pagina 2-9.

= Si se estd usando una fuente de alimentacion externa, el cable
podria estar desconectado o dafiado.

Compruebe que el cable esta firmemente conectado y no
presenta dafios.

= La fuente de alimentacion del receptor puede estar defectuosa.

Asegurese de que la fuente de alimentacién externa funciona
correctamente.

Problemas del receptor

A continuacion se exponen algunos de los problemas del receptor que
se producen con mayor frecuencia.

El receptor no puede establecer una conexion con un
ordenador o una controladora externa.
Problemas especificos del cable:

= El cable no esta bien enchufado.

» Compruebe que el conector del cable esta enchufado en el
puerto serie correcto del receptor.

» Desenchufe el cable y vuelva a conectarlo correcta y
firmemente al receptor.

» En las Secciones “Receptor NET-G3” en la pagina 1-9 y
“Especificaciones de los conectores” en la pagina A-8,
encontrara informacion sobre los conectores del receptor.

= El cable esté estropeado.
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Resolucién de problemas

Utilice un cable en buen estado. Contacte con su distribuidor
para cambiar el cable.

Problemas generales:

= El puerto del receptor utilizado para la conexidn no esta en
modo Command.

1. Conecte su receptor a un ordenador utilizando un puerto

libre (consulte la Seccion “Conexion del receptor a un
ordenador” en la pagina 2-12) y ejecute PC-CDU.

2. Haga clic en Configuration » Receiver » Ports.

3. Cambie a “Command” la entrada del puerto serie utilizado
para la conexion.

El receptor no capta los satélites durante un periodo pro-
longado.

= El receptor tiene un almanaque anticuado.

Actualice el almanaque. Para ampliar informacion consulte
“Obtencion de almanaques y efemérides” en la pagina 2-11.

= Las opciones correspondientes del receptor podrian estar
desactivadas o haber caducado (L1/L2, GPS/IGLONASS
deberén estar activados para poder recibir a los satélites).

» En “Administracion de opciones del receptor” en la
pagina 4-8, se explica la forma de comprobar las opciones
actuales.

+ Solicite un nuevo archivo OAF con las opciones que desee
activadas o habilite o amplie la validez de las opciones del
receptor correspondientes. Para obtener informacién al
respecto contacte con su distribuidor o visite el sitio web de
TPS.

» En el Manual de referencia de PC-CDU encontrara la
descripcion detallada de las distintas opciones.

El receptor capta un numero insuficiente de satélites.

= El valor de la méscara de elevacion es demasiado alto (por
ejemplo, mas de 15 grados).
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Problemas del receptor

Reduzca el valor de la mascara de elevacidn. En la pagina 3-
11 encontrara informacion para configurar la mascara de
elevacion.

= El levantamiento se esta realizando en las proximidades de
algin obstaculo (areas cubiertas por vegetacién espesa, edificios
elevados, etc.)

» Compruebe que estan activadas las casillas de reduccion de
multicamino.

1. Conecte su receptor a un ordenador e inicie PC-CDU.
Este procedimiento se explica en la seccion
“Conexion del receptor a un ordenador” en la
pagina 2-12.

2. Haga clic en Configuration » Advanced y en la
pestafia Multipath Reduction. Active las dos casillas
y haga clic en Apply.

» Desplacese a una zona en la que no haya obstaculos, si
procede.

El receptor no puede obtener soluciones de cédigo dife-
rencial ni RTK.

= Se han introducido unas coordenadas del equipo base
incorrectas.

Introduzca las coordenadas correctas del equipo base mediante
PC-CDU u otro software de obtencion de datos en el terreno.

= El receptor no esta configurado como equipo base o0 movil.
» Si el receptor debe funcionar como equipo base, compruebe

gue esté configurado correctamente. Consulte los detalles
en el Capitulo 3.

 Si el receptor debe funcionar como equipo movil,
compruebe que estd configurado correctamente. Consulte
los detalles en el Capitulo 3.

= D Las opciones correspondientes del receptor podrian haber
caducado o estar desactivadas.
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Resolucién de problemas

* En “Administracién de opciones del receptor” en la
pagina 4-8, se explica la forma de comprobar las opciones
actuales.

 Solicite un nuevo archivo OAF con las opciones que desee
activadas o habilite o amplie la validez de las opciones del
receptor correspondientes. Para obtener informacién al
respecto contacte con su distribuidor o visite el sitio web de
TPS.

» En el Manual de referencia de PC-CDU encontrara la
descripcion detallada de las distintas opciones.

= No hay suficientes satélites comunes. Para lograr un célculo
fijo, los equipos base y movil deberan captar al menos cinco
satélites comunes.

e Compruebe que los dos receptores, base y mavil utilizan el
mismo almanaque y que éste esta actualizado. VVéase
“Obtencidn de almanaques y efemérides” en la pagina 2-11.

» Compruebe las méscaras de elevacion de los receptores
base y movil. Tienen que ser idénticas. En la pagina 3-11
encontrara informacion para configurar la mascara de
elevacion.

= Discrepancia entre los estandares diferenciales utilizados en los
receptores base y movil.

Asegurese de que los receptores base y mavil usan el mismo
formato de entrada/salida para las correcciones.

1. Conecte su receptor a un ordenador e inicie PC-CDU. Este
procedimiento se explica en la seccion “Conexion del
receptor a un ordenador” en la pagina 2-12.

2. Haga clic en Configuration » Receiver y en la pestafia
Ports. Use el mismo formato de entrada/salida en ambos
receptores.

= Mala geometria del satélite (los valores PDOP/GDOP son
demasiado elevados).

Lleve a cabo el levantamiento cuando los valores PDOP sean
bajos.
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Asistencia técnica

= La maéscara de elevacion es superior a 15 grados.

Reduzca el valor de la mascara de elevacion. En la pagina 3-
11 encontrara informacion para configurar la mascara de
elevacion.

El receptor no inicia el registro de datos.

= El receptor no tiene instalada la tarjeta SD o la opcién de
memoria esta desactivada o ha caducado.

» Compruebe que la tarjeta esta insertada correctamente. Para
ampliar informacidén consulte el apartado “Instalacion de la
tarjeta CF” en la pégina 2-8.

» Compruebe que esté activada la opcion de memoria. Para
ampliar informacion consulte la Seccion “Comprobacion
del OAF del receptor” en la pagina 4-9.

= La tarjeta de memoria del receptor no tiene espacio libre.

» Descargue o borre archivos de datos para liberar espacio
para nuevos archivos (véase “Descarga de archivos desde
una tarjeta de memoria instalada” en la pagina 4-1y
“Borrado de archivos de datos de una tarjeta de memoria
instalada” en la pagina 4-5).

e Use la funcién AFRM. Consulte la configuracién del
parametro “Automatic File Rotation Mode (AFRM)” en la
pagina 3-12.

Asistencia técnica

Antes de ponerse en contacto con el servicio de asistencia al cliente de
TPS por cualquier problema relacionado con el receptor, consulte con
su distribuidor Topcon local y, ademas, intente encontrar alguna
solucion al problema en la Seccion “Comprobaciones previas” en la
pagina 5-1.

Si después de realizar los pasos anteriores, sigue necesitando
asistencia, péngase en contacto con el servicio de atencion al cliente
de TPS.
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Resolucién de problemas

Teléfono

Para poner en contacto con el servicio de atencion al cliente de TPS
por teléfono, llame al:

1-866-4TOPCON (1-866-486-7266)
de lunes a viernes
de 08:00 a 20:00 horas, horario estandar del este

Correo electronico

Para contactar con el servicio de asistencia al cliente de TPS por correo
electronico use una de las siguientes direcciones (Tabla 5-1).

Tabla 5 - 1: Direcciones de correo electronico para asistencia técnica

Para cuestiones relacionadas con... Utilice...
Hardware (receptores, antenas, firmware). hardware@topcon.com
GPS+y 3DMC psg@topcon.com
OAF options@topcon.com
RTK rtk@topcon.com
PC-CDU pccdu@topcon.com
En caso de duda... support@topcon.com

Para recibir una asistencia rapida y eficaz
proporcione una descripcion detallada del

problema.

Para obtener un servicio mejor y mas rapido cuando contacte con el
servicio de asistencia al cliente de TPS por correo electréonico, le
rogamos que facilite la siguiente informacion :

1. Modelo del receptor y ajustes de configuraciéon. En PC-CDU, haga
clic en Help » About y Save to file. Introduzca el nombre del
archivo y guardelo en su ordenador. Adjunte este archivo al
mensaje de correo electrdnico.
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Asistencia técnica

2. Las especificaciones de hardware y del sistema del ordenador en el
gue se ejecuta el software Topcon, como el sistema operativo y la
version, la memoria y capacidad de almacenamiento, la velocidad
del procesador, etc.

3. Los sintomas y mensajes o codigos de fallo que se han producido
antes y después del problema.

4. Las acciones que se han emprendido al producirse el problema. Si
es posible, incluya los pasos exactos que se han dado al producirse
el mensaje de fallo o el problema determinado.

5. Con qué frecuencia se produce el problema.

Generalmente recibira una respuesta de un representante del servicio
de asistencia al cliente en un plazo de 24 horas, dependiendo de la
gravedad del problema.

Sitio web

El sitio web de Topcon Positioning Systems ofrece informacion
actualizada sobre la linea de productos de Topcon. Desde el area de
asistencia del sitio web podra acceder a las preguntas mas frecuentes,
procedimientos de configuracion, manuales, asistencia por correo
electronico, etc.

Para acceder al sitio web de TPS utilice:
www.topconpositioning.com
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Resolucién de problemas

Notas:

5-10 Manual del Operador de NET-G3



Apéndice A

Especificaciones

Este producto TPS es un receptor GNSS de 72 canales con una tarjeta
de memoria CF extraible opcional, una carcasa de aluminio reforzado
completa con interfaz MINTER y conectores de cable.

Las especificaciones de rendimiento han sido
calculadas considerando un minimo de 6 satélites

@ GPS por encima de 15 grados de elevacion y
suponiendo que se observan los procedimientos
recomendados en este manual.

En éreas de elevado efecto multicamino y durante
periodos de gran Dilucion de Precisién en Posicion
(PDOP) y de incremento de la actividad
ionosférica, el rendimiento puede disminuir.

®

En zonas de efecto multicamino extremado o
cubiertas por vegetacion espesa aplique
procedimientos de comprobacidn rigurosos.

®




Especificaciones

Dimensiones del NET-G3

La Figura A-1 muestra las dimensiones de las mediciones para el

receptor NET-G3, incluida la colocacion de los agujeros de los
tornillos.

'-.
@ Las dimensiones estan en pulgadas.
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Figura A-1. Dimensiones del NET-G3

Use estas dimensiones cuando taladre agujeros para un montaje
permanente, utilizando cuatro tornillos #8-32 para acoplar el receptor.
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Especificaciones del receptor

Especificaciones del receptor
En las siguientes secciones se detallan las especificaciones del
receptor y sus componentes internos.

Caracteristicas generales

La tabla A-1 contiene las especificaciones generales del receptor.
Tabla A - 1: Especificaciones generales del receptor

Caracteristicas fisicas

Carcasa Aluminio extrusionado, clase IP67

Color Amarillo Topcon y Gris Topcon

Dimensiones 66 mm x 93 mm x 275 mm (Ancho x Altura x Fondo)
Peso 2,4 kg

Antena Externa

Controladora MINTER externa

Tecla Dos teclas:

Alimentacion: conexién/desconexion
FN: inicio/fin de registro de datos; cambio de modo de
informacion.

LED Seis LED:

STAT: estado del satélite y del receptor

REC: estado del registro y de los datos

RX TX: estado del médem

LINK - estado de la conexién de red (actualmente n/a)
PWR x 2 — estado de la alimentacion

Caracteristicas medioambientales

Temperatura de De-40°Ca+65°C
funcionamiento
Temperatura de De-40°Ca+75°C

almacenamiento

Humedad 100% sin condensacion

Alimentacion

Alimentacion externa | 2 puertos

Tension de entrada 6a28VCC

Consumo 4 W tipico
5 W méximo
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Especificaciones

Tabla A - 1: Especificaciones generales del receptor (Continuacion)

Bateria incorporada

Bateria de reserva para computo de tiempo y
almacenamiento de datos de almanaque;
10 afios de funcionamiento minimo

E/S

Puertos de
comunicacion

4 puertos serie RS232 de alta velocidad (1xODU-MINI-
SNAP, 3xDE-9)

1puerto USB (tipo mini B)

1 puerto Ethernet (ODU-MINI-SNAP)

Especificaciones de
los puertos

Puerto serie RS232
Velocidad de comunicacién: 460800, 230400, 115200
(predeterminada), 57600, 38400, 19200, 9600, 4800,
2400, 1200, 600, 300.
Control de flujo: RTS/CTS
Longitud: 7,8 (predeterminada)
Bits de parada: 1 (predeterminado), 2
Paridad: ninguna (predeterminada), impar, par.
Puerto USB
Version 1.1
Puerto Ethernet Completo-duplex:
10 BASE-T

Conectores

2XPWR, 4xRS232 Serie, USB, Ethernet, antena GPS,
1PPS, Indicador de evento, Frec. externa

MINTER

Seis LED externos (consulte “LED” en la pagina A-3 para
ampliar informacion)

ON/OFF control entrada (bot6n de encendido)

Control de registro de datos (botdn FN).

Caracteristicas de datos

Velocidad de actualizacion de hasta 20 Hz para
posicionamiento en tiempo real y datos brutos (cédigo y
portadora).

Precision de 10 cm en fase de codigo y 0,1 mm en fase de
portadora.

RTCM SC104 versiones 2.1, 2.2,2.3y 3.0 E/S

RTCM de base multiple

Modelos de variacion geoidal y magnética

RAIM

Incluye diferentes datums

Salida de coordenadas rectangulares

Admite formatos CMR y CMR+

A-4
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Especificaciones del receptor

Tabla A - 1: Especificaciones generales del receptor (Continuacion)

Tecnologia
Reduccién de multicamino avanzada
WAAS
Parametros PLL y DLL ajustables
NMEA

\ersion NMEA

2.1,2.2,2.3, 3.0 salida

Mensajes

GGA, GLL, GMP, GNS, GRS, GSA, GST, GSV, HDT,
RMC, ROT, VTG, ZDA

Intervalo de salida

1 Hz estéandar; 5, 10, 20 Hz opcional

DGPS

Formato de
correccion

RTCM SC104 versiones 2.1, 2.2,2.3y 3.0

Tipos de mensaje
RTCM

1, 3,9, 31, 32, 34; seleccionables por el usuario.

Intervalo de proceso

1 Hz estandar; 5, 10, 20 Hz opcional

Intervalo de salida
para datos de
correcciéon RTCM

1 Hz estandar; 5, 10, 20 Hz opcional

Mascara de elevacion

De 0° a 90° (independiente del registro de datos)

DGPS multibase

Modo de seleccidn de correccion diferencial: Méas cercano,
Mixto, Mejor (6ptimo)

RTK
Formato de CMR2 / CMR + (compatible con Trimble), RTCM SC104
correccion versiones 2.2, 2.3 6 3.0.

Tipos de mensaje
RTCM

3,18, 19, 20, 21, 22; seleccionables por el usuario

Inicializacion de
ambigiedad

OTF (L1, L1/L2)

Longitud de la linea
base

0-50 km

Tiempo de De 5 segundos a 10 minutos, dependiendo de la longitud de
inicializacion la linea base y de las condiciones de multicamino.
Intervalo de salida 1 Hz estandar; 5, 10, 20 Hz opcional

para CMR/RTCM

Altitud De 0° a 90° (independiente del registro de datos)
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Especificaciones

Tabla A - 1: Especificaciones generales del receptor (Continuacion)

Modo de solucion

Retardo (sincronizacion)
Extrapolacion (no sincronizado)

Intervalo de proceso

1 Hz estandar; 5, 10, 20 Hz opcional.

Latencia

Modo de retardo: de 20 ms a 20 ms (dependiendo de la
latencia con la que se reciben los datos de correccion desde
el receptor base).

Extrapolacion: de 20 a 30 ms

Registro de datos
brutos

El receptor puede registrar datos brutos en otro intervalo
durante el funcionamiento RTK.

Estado Fijo, flotante, DOP, estado de enlace de datos, latencia de
maddem, satélites comunes, porcentaje de fijacion
Resultados Coordenadas RTK, HRMS, VRMS, matriz de covarianza.

Nivel de resolucién
de ambiguedad

Umbrales seleccionables.
Bajo: 95%; medio: 99,5%; alto: 99,9%

Modos de levantamiento

Base o mavil

Estatico

Cinematico (Stop & Go)

RTK (cinematico en tiempo real)
DGPS (GPS Diferencial)

DGPS WAAS/EGNOS

Precision de levantamiento

Estatico, estatico
rapido

Para L1+L2 — H: 3 mm + 0,5 ppm
(x longitud de la linea base);

V:5mm + 0,5 ppm
(x longitud de la linea base)

Cinematico, RTK

Para L1+ L2, L1- H: 10 mm + 1,0 ppm
(x longitud de la linea base);
V: 15 mm + 1,0 ppm
(x longitud de la linea base).

DGPS

Posproceso: menos de 0,25 m (HRMS)
DGPS basado en RTCM: menos de 0,25 m (HRMS)

Arranque en frio
Arranque en caliente
Readquisicion

<60s
<10s
<1ls
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Especificaciones del receptor

Caracteristicas de la placa GNSS

La Tabla A-2 recoge las especificaciones generales de la placa GNSS.
Tabla A - 2: Especificaciones de la placa GNSS

Tipo de receptor (se selecciona activando el Archivo de Autorizacién de
Opciones —OAF- correspondiente).

Placa interna: Euro
160 PII

GPS: L1 (C/AyP), L2, L2C, L5 GLONASS: L1, L2
(codigo y fase) GALILEO: E2-L1-E1, E5a

Especificaciones de
seguimiento

Canales estandar

72 canales universales (G, GG, GD, GGD).

Opcional Dias

Cenicienta (véanse detalles en la pagina A-8).

Sefales

GPS/GLONASS, L1/L2 C/A, L5, GALILEO, Cédigo Py
Portadora, WAAS/EGNOS.

Funciones de seguimiento

Reduccion de

Fase de cddigo C/A y fase de portadora

multicamino

Ajuste PLL/DLL Ancho de banda, orden, ajustable
Intervalo de Codigo; seleccionable por el usuario
suavizado

SBAS WAAS opcional; EGNOS opcional

Caracteristicas de datos

Formatos

TPS, NMEA, RTCM, CMR, BINEX

Caracteristicas

Velocidad de actualizacién de hasta 20 Hz para
posicionamiento en tiempo real y datos brutos (cédigo y
portadora).

Precision de 10 cm en fase de codigo y 0,1 mm en fase de
portadora.

RTCM SC104 versiones 2.1, 2.2, 2.3y 3.0 E/S.

RTCM de base multiple

Modelos de variacion geoidal y magnética

RAIM

Incluye diferentes datums

Salida de coordenadas rectangulares

Admite formatos CMR y CMR+

Memoria

Memoria interna

tarjeta CF, extraible

Capacidad

Depende de la capacidad de la tarjeta CF instalada;
actualmente hasta 1 GB.
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Especificaciones

Tabla A - 2: Especificaciones de la placa GNSS (Continuacion)

Tipo de receptor (se selecciona activando el Archivo de Autorizacion de
Opciones —OAF- correspondiente).

Tiempo de registro | 53 horas (8 MB, 15, L1/L2, 7 satélites).

Intervalo de registro | De 0,05 a 86400 segundos, dependiendo de las opciones
adquiridas.

Los “dias Cenicienta” es una opcion que convierte un receptor GPS de
frecuencia simple en un receptor GPS+GLONASS bifrecuencia
durante 24 horas cada dos martes a la medianoche del GPS. Para
ampliar informacidn y saber las fechas especificas de los dias
Cenicienta consulte el sitio web de Topcon.

Especificaciones de los conectores

ElI NET-G3 tiene los conectores siguientes:

e 2 de alimentacion * Antena GPS
» Serie RS232C: 1xODU y e 1PPS
3xDE-9
« USB « Indicador de evento
e Ethernet » Frecuencia externa

Conector de alimentacion

El conector de alimentacion (Figura A-2) es una toma ODU de 5
patillas, de acoplamiento sellado; nimero de pieza G80F1C-
TO5QF00-0000.

Figura A-2. Conector de alimentacion
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Especificaciones de los conectores

La Tabla A-3 recoge las especificaciones del conector de
alimentacion.

Tabla A - 3: Especificaciones del conector de alimentacion

Numero Denom~. de la Dir Detalles

sefal
1 Power_INP P Entrada de CC de 6 a 28 voltios
2 Power_INP P Entrada de CC de 6 a 28 voltios
3 Power_GND p Conexion a tierra, retorno
4 Power_GND P Conexion a tierra, retorno
5 Auz_Power P Entrada de CC de 6 a 28 voltios

Conectores serie RS232C

El conector serie RS232 del panel frontal (Figura A-3), es una toma
ODU de 7 patillas, de acoplamiento sellado; nimero de pieza
G80F1C-T07QC00-0000.
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Figura A-3. Conector serie R§232

En la Tabla A-4 se detallan las especificaciones del conector de cable
RS232.

Tabla A - 4: Especificaciones del conector RS232

Numero Denom~. de la Dir Detalles
senal
1 Ext_PWR 0] Salida de CC de 6 a 28 voltios a una
carga maxima de 0,5 A
2 GND - Tierra de sefial
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Especificaciones

Tabla A - 4: Especificaciones del conector RS232 (Continuacion)

Numero Denom~. dela Dir Detalles
senal
3 CTS | Preparado para enviar datos
4 RTS (0] Solicitud de envio de datos
5 RXD | Recepcién de datos
6 TXD (¢} Transmision de datos
7 No utilizado

El conector serie RS232 del panel trasero (Figura A-4), es un conector
D-shell de 9 patillas, de acoplamiento sellado.
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Figura A-4. Conector serie R§232
En la Tabla A-5 se detallan las especificaciones del conector de cable

RS232.
Tabla A - 5: Especificaciones del conector RS232
Numero Denom~. de la Dir Detalles
senal
1 No se utiliza
2 RXD | Recepcion de datos
3 EXD (0] Transmision de datos
4 No se utiliza
5 GND Tierra de sefial
6 No se utiliza
7 RTS (0] Solicitud de envio de datos
8 CTS | Preparado para enviar datos
9 No se utiliza
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Especificaciones de los conectores

Conector USB
El conector USB es del tipo MINI-B (Figura A-5).

L I
t
No.5 €——— No,1
Figura A-5. Conector USB
La Tabla A-6 recoge las especificaciones del conector USB.

Tabla A - 6: Especificaciones del conector USB

Nidmero Denonl. dela Dir Detalles
senal
1 VDD P Entrada de alimentacion de bus
2 V- 110 Datos -
3 V+ 110 Datos +
4 No utilizado

Conector Ethernet

El conector Ethernet es del tipo ODU-MINI-SNAP de 12 patillas
(Figura A-6).

Figura A-6. Conector Ethernet
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Especificaciones

La Tabla A-7 recoge las especificaciones del conector Ethernet.

Tabla A - 7: Especificaciones del conector Ethernet

Numero Denom~. dela Dir Detalles
senal
1 LAN TXD+ 0o Transmision de datos +
2 LAN TXD- 0] Transmision de datos -
3 LAN RXD+ | Recepcidn de datos +
4 LAN RXD- | Recepcidn de datos -
5 No se utiliza
6 No se utiliza
7 No se utiliza
8 No se utiliza
9 No se utiliza
10 No se utiliza
11 No se utiliza
12 No se utiliza

Conector de antena GPS
El conector para antena externa es del tipo N.

Tabla A - 8: Especificaciones del conector para antena externa GPS

Tipo Denom~. dela Dir Detalles
senal
TNC Ant_IN | Entrada de RF desde LNA, 60 mA a
5,0 voltios
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Especificaciones de los conectores

Conector 1PPS

El conector 1PPS es un acoplamiento coaxial hembra de la serie BNC,
Kings Electronics, nimero de pieza KC-79-108.

Tabla A - 9: Especificaciones del conector 1PPS

Conector Hembra BNC
Polaridad Impulso positivo
Nivel de sefial >=2 V, TTL a una carga de 50 ohmios

Ancho del impulso 3,3 mseg (pulso normal); 4,9 mseg (impulso

acentuado)
Tiempo de ascenso <=3 nseg
Tiempo de bajada <=3 nseg

Borde de

. N Ascenso/bajada (seleccionable por el usuario)
sincronizacién

+-2.5 nseg Deben cumplirse determinados requisitos
para este nivel de precision. Para ampliar informacion,
pongase en contacto con el centro de asistencia técnica.

Precision de la
sincronizacion

Periodo 10 a 1000000000 mseg

-500000000 to 500000000 mseg; -500000 a 500000

Desplazamiento
nseg

Tiempo de referencia GPS, GLONASS, UTC (USNO), UTC (SU)

Conector indicador de evento

El conector Indicador de evento es un acoplamiento coaxial hembra de
la serie BNC, Kings Electronics, nimero de pieza KC-79-108.

Tabla A - 10: Especificaciones del conector Indicador de evento

Conector Hembra BNC

Polaridad Impulso positivo/negativo

Niveles de tension Bajo “0” desde -40 V hasta +0,8 V Alto “1” desde +1,4 V
CC ldgicos hasta +40 V

Impedancia de 2 kOhmios para -40 V hasta 0 V' y +3,3 V hasta +40 V
entrada >100 kOhmios para 0 V hasta +3,3 V

Ancho del impulso >=100 nseg

Borde de Ascenso/bajada (seleccionable por el usuario)

sincronizacion
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Especificaciones

Tabla A - 10: Especificaciones del conector Indicador de evento (Continuacion)

Conector Hembra BNC
Precision de la 5 nseg Deben cumplirse determinados requisitos para
sincronizacion este nivel de precision. Para ampliar informacion,

poéngase en contacto con el centro de asistencia técnica.

Tiempo de referencia | GPS, GLONASS, UTC (USNO), UTC (SU)

Conector de frecuencia externa

El conector de frecuencia externa es un acoplamiento coaxial hembra
de la serie BNC, Kings Electronics, nimero de pieza KC-79-108.

Tabla A - 11: Especificaciones del conector de frecuencia externa

Salida

Conector | BNC; impedancia de 50 ohmios

Frecuencia| 20 MHz

Amplitud | 0,6 Vp-p a 50 ohmios

Onda| sinusoidal

Armonica| -19 dBc

Esplrea| -70dBc

Entrada

Conector | BNC; impedancia de 50 ohmios

Frecuencia| 5/10/20 MHz

Sensibilidad | 0,5...3 Vp-p a 50 ohmios
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Especificaciones de los conectores

Tarjetas CF compatibles con el NET-G3

Las siguientes tarjetas CF se han probado con éxito en el NET-G3 y se
pueden usar con seguridad con el receptor. Antes de usar cualquier otra
tarjeta CF, consulte con el Servicio de Atencion al Cliente de TPS.

Tabla A - 12: Lista de compatibilidad de tarjetas CF con NET-G3

N° de pieza de

Capacidad (MB) Topcon N° de pieza del fabricante
SanDisk

16 22-006011-16 SDCFBI-16-101

32 22-006011-32 SDCFBI-32-101
SDCFBI-32-201-00
SDCFBI-32-201-00

64 22-006011-64 SDCFBI-64-101
SDCFBI-64-201-00

80 22-006011-80 SDCFBI-80-101

96 22-006011-96 SDCFBI-96-101

128 22-006011-128 SDCFBI-128-101
SDCFBI-128-201-00

160 22-006011-160 SDCFBI-160-101

192 22-006011-192 SDCFBI-192-101

256 22-006011-256 SDCFBI-256-201-00

512 22-006011-512 SDCFBI-512-201-00

1024 22-006011-001 SDCFBI-1024-201-00

SiliconSystems

32 22-006011-32 SSD-C32M1-3012

128 22-006011-128 SSD-C12MI-3012

256 22-006011-256 SSD-C25M1-3012

512 22-006011-512 SSD-C51MI-3012

1024 22-006011-001 SSD-C01GI-3012

White Electronics Designs

128 22-006011-128 WED7P128CFA7000125

256 22-006011-256 WED7P256CFA7000125

512 22-006011-512 WED7P512CFA7000125

1024 22-006011-001 WED7P1G0CFA7000125

P/N 7010-0761
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Especificaciones

Notas:
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Apéndice B

Advertencias de
seguridad

Advertencias generales

|.|.|.| Los receptores TPS estan disefiados para

). levantamientos topogréaficos y actividades
relacionadas (como pueden ser el calculo de
coordenadas, distancias, &ngulos y profundidades y el
registro de estas mediciones). Este producto nunca
deberd usarse:

* Sin que el usuario haya estudiado
minuciosamente este manual.

« Cuando se hayan desactivado sistemas de
seguridad o se haya alterado el producto.

« Con accesorios no autorizados.

ADVERTENCIA
—

« Sin las adecuadas medidas de proteccion en la
zona del levantamiento topografico.

* Incumpliendo la legislacion, normas o
reglamentos de aplicacion.

entornos peligrosos. Se permite el uso con lluvia o

% Los receptores TPS no deberan utilizarse nunca en
nieve durante periodos limitados.




Advertencias de seguridad

Advertencias de uso

embalaje adecuado, o se maltrata de cualquier otra
forma, se pueden producir errores de medicién.

El propietario debera comprobar periodicamente el
producto para asegurarse de la exactitud de sus
mediciones.

A Si el producto se cae o se altera, se transporta sin el

Si el producto no funciona de forma adecuada informe
inmediatamente a TPS.

So6lo estan autorizados a mantener o reparar este
producto los centros de servicio de garantia TPS

autorizados.
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Apéndice C

Informacion de
conformidad

Las siguientes secciones recogen la informacion de la conformidad del
producto con las normas de uso estatales.

Conformidad FCC

Este dispositivo es conforme con lo establecido en el Apartado 15 de
la normativa FCC. El funcionamiento del receptor cumple los dos
siguientes requisitos:

1. El dispositivo no debera causar interferencias perjudiciales y

2. El dispositivo debera soportar cualquier interferencia recibida,
incluidas aquellas que pudieran causar un funcionamiento no
deseado.

Este equipo ha sido probado y cumple lo estipulado en el Apartado 15
de la normativa FCC con los limites establecidos para los dispositivos
digitales. Estos limites estan concebidos para proporcionar una
proteccion razonable contra las interferencias perjudiciales en
instalaciones domeésticas. Este equipo genera, usa y puede emitir
energia de radiofrecuencia y si no se instala y utiliza de acuerdo con
las instrucciones puede causar interferencias perjudiciales para las
comunicaciones por radio.

Sin embargo, no se garantiza que no se produzcan interferencias en
instalaciones particulares.

Si este equipo causase interferencias a la recepcion de los equipos de
radio o television que pudieran verificarse encendiendo y apagando el
aparato, se recomienda al usuario que trate de corregirlas aplicando
una o varias de las siguientes medidas:

» Cambie la orientacion o la situacion de la antena receptora.
 Aleje el equipo del receptor.
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Informacion de conformidad

» Enchufe el equipo a una toma de corriente de un circuito
distinto al que alimenta al receptor.

» Consulte otras soluciones con el distribuidor o con un técnico
de radiotelevision experto.

esté expresamente aprobado por la parte responsable
de otorgar la conformidad podria anular su
autorizacion a utilizar dicho equipo.

Cualquier cambio o modificacién en el equipo que no

Cualquier cambio o modificacion en el equipo que no esté
expresamente aprobado por la parte responsable de otorgar la
conformidad podria anular su autorizacion a utilizar dicho equipo.

Conformidad con las normas de la
Comunidad Europea

El producto que se describe en este manual cumple las directivas
RTTE y EMC de la Comunidad Europea.

Directiva WEEE

La informacidn siguiente esta dirigida exclusivamente a estados
miembros de la UE:

El uso del simbolo indica que este producto no se puede tratar como
un residuo doméstico. Al garantizar la eliminacion correcta de este
producto contribuira a evitar las consecuencias negativas para el
medioambiente y la salud de las personas que podrian derivarse de un
tratamiento de eliminacion inadecuado. Para ampliar informacion
acerca de la recogida y el reciclado de este producto le rogamos que se
ponga en contacto con su proveedor.
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Apéndice D

Terminos de la
garantia

Los equipos de posicionamiento por laser y electronico de TPS estan
garantizados contra defectos del material o de fabricacion, en
condiciones normales de uso y aplicacién de acuerdo con lo
establecido en el presente Manual. La garantia del equipo se otorga por
el periodo indicado en la carta de garantia que acompafia al producto,
comenzando desde el dia de la venta del equipo al comprador original
por un distribuidor autorizado de TPS ().

Durante el periodo cubierto por la garantia, TPS podrd, a su eleccién,
reparar o sustituir el producto sin cargo adicional. Las piezas y los
productos de repuesto se suministraran en intercambio y podran ser
reparados 0 nuevos. Esta garantia limitada no incluye el servicio de
reparacion de los dafios ocasionados al producto como consecuencia
de accidentes, desastres, mal uso, abuso o modificacion del producto.

El servicio de garantia se puede solicitar a cualquier proveedor de
servicios de garantia TPS autorizado. Si el producto se envia por
correo, el comprador aceptara asegurar el producto o asumir el riesgo
de pérdida o dafios durante el transporte, pagar por adelantado los
gastos de envio hasta el lugar del servicio de garantia y utilizar el
embalaje de envio original o uno equivalente. El paquete debera ir
acompafiado de una carta en la que se describa el problema o defecto.

La Unica compensacion a la que tendra derecho el comprador sera la
sustitucion en los términos indicados anteriormente. TPS no se
responsabilizaré en ningun caso de los dafios de cualquier tipo ni otras
reclamaciones, incluidas las reclamaciones por lucro cesante, pérdida
de descuentos u otros dafios accidentales o consecuentes derivados del
uso o de la imposibilidad de uso del producto.

1. Lagarantia por defectos de la bateria, el cargador o el cable de Topcon es
de 90 dias
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Términos de la garantia

Notas:
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